
Version 1.00
Revision A
April 2018

 

 

 

 

SITEWORKS
SITE CONTROLLER SOFTWARE

USER GUIDE



Corporate Office

Trimble Inc.
935 Stewart Drive
Sunnyvale, CA 94085
USA
www.trimble.com

Heavy Civil Construction Division

Trimble Civil Engineering & Construction
10368 Westmoor Drive
Westminster, Colorado 80021
USA

800-361-1249 (Toll Free)
+1-937-245-5154 Phone
+1-937-233-9441 Fax
www.trimble.com

Email: trimble_support@trimble.com

Legal Notices

© 2018, Trimble Inc. All rights reserved.

Trimble, the Globe & Triangle logo, and Terramodel are 
trademarks of Trimble Inc., registered in the United States 
and in other countries. AutoBase, VRS, and xFill are 
trademarks of Trimble Inc.  Microsoft and Windows are either 
registered trademarks or trademarks of Microsoft 
Corporation in the United States and/or other countries.

The Bluetooth word mark and logos are owned by the 
Bluetooth SIG, Inc. and any use of such marks by Trimble Inc. 
is under license. 

All other trademarks are the property of their respective 
owners.

Release Notice

This is the April 2018 release (Revision A) of the Trimble 
Siteworks Software User Guide. It applies to version 1.00 of 
the software.

Product Limited Warranty Information

For applicable product Limited Warranty information, please 
refer to the Limited Warranty Card included with this Trimble 
product, or consult your local Trimble authorized dealer.

Trimble Siteworks Software User Guide | 2

http://www.trimble.com/
http://www.trimble.com/
mailto:trimble_support@trimble.com


Safety Information
Before you use your Trimble product, make sure that you have read and understood all 
safety requirements.

WARNING – This alert warns of a potential hazard which, if not avoided, could 
result in severe injury or even death.

CAUTION – This alert warns of a potential hazard or unsafe practice that could 
result in minor injury or property damage or irretrievable data loss.

NOTE – An absence of specific alerts does not mean that there are no safety risks involved.

Vehicle safety

WARNING – When you select the Vehicle mode, the following warning message 
appears: 
WARNING: Do not operate Siteworks while driving the vehicle. Failure to heed this warning 
may result in a collision causing property damage or personal injury.
Do not interact with the touch screen, keyboard, or software in any way while the 
vehicle is moving. While the vehicle is moving, the software provides a continuous 
display of position and data that can be seen at a glance. Operating the device or 
interacting with the software while the vehicle is moving can be a distraction for the 
operator, and may result in collision causing property damage or personal injury.
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Introduction
Overview

Related information

Technical support

This manual provides you with the necessary information to perform measurement and 
stakeout tasks with the Trimble® Siteworks site controller software. To perform the many 
tasks that the Siteworks software is capable of, you need the Siteworks site controller 
software running on a Trimble controller that is either connected to a Precision or 
Location GNSS system, or to a total station. You can also use the internal GPS of the 
controller to locate objects. The Siteworks software is the field software that runs on a 
Trimble TSC7 controller, Trimble T10 Tablet or the Trimble Site Tablet 10. For presentation 
and training purposes, a software emulator that runs on a Microsoft® Windows® 10 Pro 
operating system is also available on the Siteworks webpage of the Trimble website 
(www.construction.trimble.com/siteworks).

Even if you have used other GNSS, GPS and total station products before, Trimble 
recommends that you spend some time reading this manual to learn about the special 
features of this product. If you are not familiar with GNSS, GPS, or total stations visit the 
Trimble website (www.trimble.com).

1
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Introduction

Overview
The Siteworks software is a site measurement tool that streamlines earthworks and 
surface finishing operations. It enables construction contractors to measure material 
volumes, monitor grades and laid material thicknesses, and to perform various site layout 
tasks such as point, line, and surface stakeout, in addition to survey measurement of 
points, lines, and surfaces.

Start up and set up of the sophisticated GNSS and total station technology is quick and 
easy. The software manages data for multiple project sites, single large project sites, and 
large sites that have been divided into zones. When a field engineer, grade checker, or 
surveyor opens a work order, the software opens all the data files needed to complete that 
work order. Because the software delivers results immediately, informed decisions can be 
made in the field.

The Siteworks software can also be used to check site grading operations that have been 
performed using a machine control system, such as a Trimble GCS900 grade control 
system or Trimble Earthworks. If your organization does not have a 3D machine control 
system, the system provides site control, grade checking, progress volumes, and stakeout 
capabilities to facilitate earthmoving operations.

The field engineer can quantify progress, check data, and set out the information needed 
to keep the machines moving. The Siteworks system tracks activities at each site and keeps 
a continuous record of all results. Related data is stored, together, as a permanent 
construction record and is output as a TXT or DXF file. Back at the office, the software 
delivers comprehensive operation analysis data.

Related information
Sources of related information include the following:

 l Release notes – The release notes describe new features of the product, information 
not included in the manuals, and any changes to the manuals. They can be 
downloaded from Technical Information / Documentation section on the Trimble 
website.

 l Trimble training courses – Consider a training course to help you use your GNSS 
system to its fullest potential. For more information, go to the Trimble website at 
www.trimble.com/Support/Index_Training.aspx.
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Introduction

Technical support
If you have a problem and cannot find the information you need in the product 
documentation, contact your local dealer. Alternatively, go to the Support area of the 
Trimble website (www.trimble.com/Support/). Select the product you need information on. 
Product updates, documentation, and information relating to support issues are available 
for download.
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Starting the Software
Installing the software

Starting the software

System information

Installing the software
The software and its modules are downloaded and installed through the Trimble 
Installation Manager (TIM), which can be downloaded from 
www.trimble.com/installationmanager/.   For the TSC7, T10 Tablet and SiteTablet 10 devices, 
TIM is installed directly on the devices, and the devices must be connected to the Internet 
via Wi-Fi or Ethernet through the available docking stations, or USB to Ethernet adapters.

TIM needs to be installed directly on the device, and the device must be connected to the 
Internet. The License Manager checks which software options were purchased for the 
specific controller with this serial number and checks for the latest version of the software 
that is available for this controller.

Note that the Siteworks version that the controller is entitled to is determined by the serial 
number of the controller and the status of the software warranty expiration date.  The 
latest versions of the Siteworks software are only available to users with software warranty 
expiration dates within one month of the release date of the software.  Please contact your 
dealer if your controller is out of warranty.  For brand new controllers, the warranty period 
begins when the Siteworks software is first downloaded to the device through a successful 
connection to the Trimble Installation Manager.

2

Trimble Siteworks Software User Guide | 11

http://www.trimble.com/installationmanager/


Starting the Software

Starting the software
To start the Siteworks software on your controller, double-click on the Siteworks icon on 
the controller's desktop. The Siteworks software will start in the Open Project dialog where 
you can select an existing project, design, and work order on your controller or create a 
new one. 

The last used Project, Work Order and Design will be displayed.  Click on the down arrow to 
the right of the fields to select a different Project, Work Order or Design, or click on the plus 
symbol to create a new one.

After accepting the selection, the software loads your data and the map view. If you have 
previously connected a rover receiver to the site base station or were using a total station, 
the software tries to automatically connect with the last used device configuration.
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Starting the Software

If the software is not automatically connecting to your positioning device, tap on the 
Project Setup menu by going to the main menu and tap Connect Deviceand select either 
GPS or Total Station . The Receiver Setup menu opens to start the connection to the 
positioning device.

System information
The System Information dialog has multiple tabs that contain information about the 
current version of the Siteworks software, which modules are enabled, which positioning 
sensors are connected, which firmware the sensors have, and what language to display. 

From the main menu, select Settings / System Info. You must have an open site and work 
order to access this menu.

If you have purchased a module after the controller was activated, activate the new 
module by tapping Update License in the Modules tab.
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Starting the Software

In the Display tab, you can toggle between the different supported and installed 
languages:
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Menus
Home menu

The Project Setup menu

The GPS menu

The Total Station menu

The Measure menu

The Stake menu

The COGO menu

The GPS menu

The Settings menu

The Exit menu

The Siteworks software is a menu-driven system. From the Map screen you can access the 

main menu through the Home button  at the top left of the screen (also known as the 
Hamburger menu). 

3
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Menus

Home menu
The Home menu is the main menu of the Siteworks software. It contains the following 
buttons:

To access it from any map screen, tap .
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Menus

The Project Setup menu

The Project Setup menu contains options to manage the details of the project, the tools to 
create, open, review, and select projects, designs, and work orders. You can also change 
the design referenced by the current work order and create new designs.

The change and review project buttons are used to create, open, review, and select sites, 
designs, and work orders. You can also change the design referenced by the current work 
order and create new designs.

From the Home menu, tap Project Setup. This shows the options Change Project and 
Review Project:

Tap Change Project to create a new project, design, and work order, or select from existing 
sites on the controller. At the top of each list, the software displays an option to create a 
new project, design, or work order, the last three items that have been used, and then all 
remaining data on the controller:
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Menus

Tap Review Project to show the names of the currently loaded project, work order and 
design, along with the Settings of distance and angle units, coordinate order and other site 
settings.

The third menu Connect Device is used to connect a total station or GPS to Siteworks. 

Select Connect Device and then either Total Station or GPS. 

This takes you through the setup of the selected instrument. For information on the use of 
these, see Measuring with GPS, page 127  or Measuring with a Total Station, page 154.

When a device is connected, the tabs under Project Setup change. These different menus 
are outlined below. See The GPS menu, page 19 and The Total Station menu, page 20. 

Trimble Siteworks Software User Guide | 18



Menus

The GPS menu
When a GPS is connected to Siteworks, use this menu to connect to the rover receiver, 
carry out a site calibration, and select a predefined coordinate system. You can also 
recheck the system setup on a control point.

From the Home menu, tap Project Setup.

The following commands are available:

Command Description

Set up and start a GNSS base station, rover receiver,  or start 
the internal GPS of the controller.

Select a predefined coordinate system from the coordinate 
system library.

Perform or resume a single-point, two-point, or multi-point 
site calibration, and review the calibration when it is 
completed. 

Check the existing site calibration and base station location by 
checking in on a known control point.
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Menus

The Total Station menu
When a total station is connected to Siteworks, use this menu to connect to the instrument 
and carry out total station setup to establish the position and orientation of the 
instrument. General functions in this menu include being able to recheck the system setup 
on a control point or set the total station into Machine Control mode.

From the Home menu, tap Project Setup.

The following commands are available from this menu:

Command Description

Connect to the total station using either a cable, Bluetooth® 
wireless technology, or a 2.4 GHz radio for robotic operation.  

After a connection is established, this button changes to a 
disconnect button, that when pressed will disconnect from 
the total station and place it into standby mode. 

Set up the total station and establish its position and 
orientation on the site using a known control point or 
arbitrary location (also known as free station or resection) 
methods. 

Set up instrument for machine control.

Check an existing instrument setup on a known control point.
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Menus

The Measure menu

The software always initially starts in Measurement mode. Use this option to switch 
between stakeout and measure modes.

From the Home menu, tap Measure.

In this menu, you can accomplish all site measurement functions including:

 l Grade checking

 l Material thickness checking

 l Topographic measurements to create surface models (for example, volume 
computations)

 l Site point and line feature measurements to record the location of non-surface 
features

 l Real-time cut/fill information against a selected design model

 l Stockpile Scanning if a total station is connected

Before you use this menu, you must connect and set up your GNSS or total station in the 
Home menu. If you have not yet done a system setup when you select an option in this 
menu, the software automatically prompts you to go through the station establishment 
process for either a total station or the rover setup for GNSS.

In the Point type of the Measure Type tab, you can define if measured points  are to be 
stored as part of a Digital Terrain Model (DTM) surface or only as a site feature and not 
included in any surfaces. This menu can also be accessed from the main screen by clicking 
the measure type button 

Select Surface or Feature from the Point type field to choose if the point or line will be 
included in a surface or just stored as a feature. When the Advanced Measurement 
module is installed, the measurement type is controlled by the settings in the FXL file 
Feature Code Library for each feature code.
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Menus

Lines are measured by selecting one of the Line tabs: New Line or Existing Line.  

Selecting Existing Line enables the selection of an existing line from a table and the 
continuation of measuring that line from the last measured end point along it.  

Selecting New Line requires entering a Line Name, and choosing what kind of line type it is.  
Line types that are included in the DTM surface measurement are Breaklines, Volume 
Boundaries, and Outer Boundaries.  Lines and areas are not included in the DTM surface 
measurement.
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Menus

The Stake menu

The Stake menu contains all stakeout functions including staking points, lines, alignments, 
surfaces, side slopes, catch points, and road features. 

From the Home menu, tap Stake.

After entering the stakeout function, the object selection screen appears. Select the object 
that you want to stake out either by tapping directly on it in the map or from the list in the 

top right corner of the screen, by selecting .

To stake a user-defined plane, select   .

To define a new line to stake, select   .

After you select an object, multiple stake methods are available that differ depending on 
the type of object that you selected. For more information, see Stakeout Workflow, page 98.
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Menus
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Menus

The COGO menu

The COGO (Coordinate Geometry) menu contains a number of features, such as area, 
distance, bearing, slope, and point generation functions that can be used to generate 
points for stakeout operation from CAD or measured data in the currently loaded design 
and work order. The menu also provides access to review and edit functions for editing 
breaklines and deleting points or lines to resolve surface modeling problems. A point 
manager function is also available to view, edit, create, and delete points in a  work order in 
a list format.

From the Home menu, tap COGO.

The following commands are available from this menu:

Command Description

View or delete point and lines, add breaklines and 
boundaries, compute distance, areas and angles, calculate 
surface volumes (stockpiles) or periodic progress volumes, 
generate contours of measured data, and enter 3D surface 
viewer mode. 

Create points, lines, boundaries, arcs, and circles by a variety 
of methods including free point, bearing and distance,  radius, 
and offset to a line. To create free points, tap the screen or 
enter its coordinates. 

Enter a basic road alignment and road cross sections in the 
field. This function requires the Roading module.
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Menus

The Data Management menu

Use this menu to view and edit points, import and export data or selected design 
information to an external memory device such as a USB flash drive. An alternative is to use 
the Connected Community for real time data sharing. The menu also includes export 
functions for data use in the GCS900, Earthworks or AccuGrade grade control systems.

From the Home menu, tap Data Management.

The following commands are available from this menu:

Command Description

View, create, edit, and delete control, stakeout, and design 
points in a list format of points in the currently selected work 
order.

Export measured data as a CSV custom point file format, DXF 
file, Record.txt file, or Network measurements for Advanced 
Measurement Module users. 

 

Write the surface data that was measured in the field to a new 
design surface  as a .TTM file.

Export a design to a CompactFlash card or USB drive for use 
with the GCS900 Grade Control System or Trimble 
Earthworks.Export measured data as a CSV custom point file 
format, DXF file, Record.txt file, or Network measurements for 
Advanced Measurement Module users. 

View a data log of the project to date including tasks 
performed and their detailed measurement settings. Import a 
comma, tab, or semicolon delimited point file in various 
formats. For more information, see page 53.

View a summary of all the grades checked.
Export a design to a CompactFlash card or USB drive for use 
with the GCS900 Grade Control System.

Synchronize data with the Connected Community service 
using the Wireless Data Sync function.
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Menus

Command Description

Enter the device credentials to access the Trimble Connected 
Community service.
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Menus

The Settings menu

Use this menu to change or view the current settings in the project. This is the menu where 
you can view the system settings and access multiple project settings such display, 
eBubble, and the various types of measurement settings. 

From the Home menu, tap Settings.

The following commands are available from this menu:

Command Description

Access the current software version, modules and license 
information and change the display language. 

Change display options for measure mode, the design and 
the map layers. Change the screen view direction and switch 
which panels are displayed. 

 

Calibrate the eBubble and change the tolerance and 
sensitivity settings. 

Switch measurement modes between standing, walking, 
vehicle, static and EZ level. 

Change what information is displayed in the information bar 
and panel. 

View and change the measurement tolerances and settings.

View and change the stakeout tolerances and settings.

View and change the settings when in a project utilizing road 
stakeout.

View and change the settings for a surface.

View and change the settings when a second surface is being 
used.
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Menus

Command Description

Select and set the settings for a reference line.

Set the tolerances for the avoidance zones loaded into the 
project.

View and change the settings to be used when staking a catch 
point.

The Exit menu

This menu closes the Siteworks software, and optionally can power down the receiver.

From the Home menu, tap Exit.
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Measurement Screen
Measure modes

Status bar

Precision GNSS control icons

Map controls

The Total Station menu

Toggling between the panels

Info bar

Antenna Height/Target Height

The Siteworks software is a menu-driven system. From the Map screen you can access the 
main menu through the Home button at the top left of the screen. The map screen 
contains three panels. One large panel called the main panel, and two small panels on the 
left side of the screen called the top panel and bottom panel. These can be set up to 
display different types of information such as a plan view, 3D surface viewer, eBubble and 
cross sections. 

4
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Measurement Screen

Measure modes
The Measure mode controls a number of functions for the GPS receiver and total station. 
There are multiple modes available, which you can switch between by tapping the Measure 
Mode icon on the right  side of the main panel below the map control bar.

GPS measure mode

GPS measure 
mode

Name Description

Standing Walk to a point and then take a single measurement.

Walking Walk the site and continuously take measurements. Points are 
measured based on a setting for horizontal distance and 
elevation change, or at regular time intervals. 

Vehicle Drive the site in a vehicle. Points are stored based on a setting 
for horizontal distance and elevation or at regular time 
intervals.  This feature contains an additional function to 
measure the antenna height by parking the vehicle over a 
known elevation point. 

Static Measure a point for a longer period and to achieve a greater 
accuracy  through position averaging. 

EZ Level Graphically display elevations on a site relative to an arbitrary 
benchmark.
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Measurement Screen

Total Station measure mode

Total Station
measure 
mode

Name Description

Standing Walk to a point and then take a single measurement.

Walking Walk the site and take continuous measurements. Points 
are stored based on a setting for horizontal distance and 
elevation change or at regular time intervals, which can be 
set by tapping the Measure mode icon either in the status 
bar or in the Trimble icon menu. 

Vehicle Drive the site in a vehicle. Points are stored based on a 
setting for horizontal distance and elevation change or at 
regular time intervals, which can be set by tapping the 
Measure mode icon either in the status bar or in the 
Trimble icon menu.

This feature contains an additional function to measure 
the antenna height by parking the vehicle at a known 
elevation point. Measurements are acquired at 3 Hz for all 
prisms except the MT1000 and MT900. These prisms are 
capable of producing measurements at 20 Hz.

Averaging Measure a point in multiple faces/rounds and display the 
standard deviation between measurements.

DR Measure a point using a DR reflectorless total station.
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Measurement Screen

Total Station
measure 
mode

Name Description

DR Target Measure a point using a DR reflectorless total station that 
adds a user-defined distance amount, up to 5 m, along the 
straight line beam path from where the beam reflects off 
the surface. 

DR Scanning Operate the total station in a scanner mode  by manually 
turning the total station and setting a distance interval to 
measure points over. 

DR 
Averaging 

Measure a point in DR mode using multiple faces/rounds 
and display the standard deviation between 
measurements.

EZ Level Graphically display elevations on a site relative to an 
arbitrary benchmark.

The icon below the Measure mode icon on the right side of the main panel below the map 
control is the measure type icon. This is used to select either point, existing line or new line. 

When in stakeout mode, this icon changes to enable you to select the stake method. The 

options in this tab are discussed in Slope staking, page 108 .
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Measurement Screen

Status bar
The status bar at the top right of the screen contains relevant information about the 
current status of the positioning system, battery status, measure mode, and 
measurement type. The icons change slightly depending on the positioning device. The 
following icons are typically available:

GPS mode

Icon Description

The radio connection status to the base station. Clicking on this 
provides access to the Radio Information menu. This icon changes 
depending on how corrections are being received. 

The number of satellites being tracked and the horizontal and vertical 
precision of the GNSS position solution. Clicking on this opens the GPS 
status menu.

The battery level of the controller and externally connected GNSS 
receiver. 

Total Station mode

Icon Description

Indicates the total station is in Target Tracking mode and provides 
access to the total station control panel. A lock button appears when 
the instrument is locked onto a prism.

Indicates the total station is in Standard mode and provides access to 
the total station control panel. A lock button appears when the 
instrument is locked onto a prism.

Shows the battery level of the controller and total station.
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Measurement Screen

Precision GNSS control icons
When using the internal GPS or while connected to an external SPS receiver, an icon panel 
appears at the top right of the screen. 

GPS mode

This icon… shows…

how many satellites are being tracked  and the horizontal and vertical 
precision of the GNSS position solution.

the radio connection status.

the battery level of the controller and GNSS receiver.

Tap one of these icons to show more detailed information. To access the sky plot of the 
current satellite constellation, tap the Satellite or the Precisions icon:

The icons in the sky plot represent the following satellite constellations:

This icon… shows…

GPS
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Measurement Screen

This icon… shows…

BeiDou

Galileo

GLONASS

QZSS

SBAS

Satellite not used in position

The Settings tab, which appears when the controller is connected to an SPS receiver, is a 
shortcut to the RTK Precision option. If the precisions of the GNSS rise above these values, 
the info bars flash red and a warning pops-up if a measurement is attempted. The GPS 
Only check box enables you to toggle between using GPS and GNSS satellite 
constellations. The current Position, Horizontal, and Vertical Dilutions of Precision (DOP) 
values are also displayed.

While in the GPS Status screen, you can set the elevation mask of the GNSS rover receiver 
by pressing Ctrl+M on the controller’s keyboard. Note that you must use the virtual 
Windows keyboard on a T10 or Site Tablet 10 to access the Ctrl key. The rover’s elevation 
mask setting will also govern the elevation mask used for the satellites received from a base 
station, as the rover will ignore all satellite data from the base for those satellites below the 
mask elevation value set on the rover.

Tap the radio icon to open the Radio Information screen, where you can view information 
about the model of the radio, its current channel, the base name, and reception 
information. You can change the radio channel in this screen.
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Map controls
The icons on the right of the main panel enable you to move around the screen and toggle 
information on and off to improve readability when there is a lot of information shown on 
the screen. They change depending on what data has been selected to be displayed in the 
main panel. 

Plan View and Cross Section

Icon Description

Center the map on the current location.

Zoom to the extents of the file.

Zoom to a user-defined box (use a stylus to draw a box on the screen).

Zoom in.

Zoom out.

View the map display options.

Enables you to customize what is displayed on the map screen. You can 
choose the information that you want to view for the task rather than 
cluttering the screen with too much information.

Pinch-to-zoom capabilities are present across all panels if using a TSC7, T10 or Site Tablet 
10 controller.  

3D Surface Viewer

Icon Description

Center the map on the current location.

Zoom to the extents of the file.
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Icon Description

3d Orbit by clicking on the map and using the touch screen.

Zoom. To zoom in, click this and swipe up on the touch screen. To zoom 
out, swipe down on the touch screen. 

Toggle on or off the TIN/ surface edges. 

Toggle on or off the stakeout flags.

Open the Surface Selection menu to choose which surface to display.
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Map Options: Measure tab
Use the Measure tab to filter the different measured data that is being displayed:

Select this 
option…

to display…

Point names the point names of every point on the map view.

Point elevations the point elevations of every point on the map view.

Control points control points on the map view.

Measured surface measurements that were recorded as a surface.

Coverage grid a coverage grid map that shows cut/fill/in tolerance values as shades 
of red/blue/green respectively between a measured point and the 
selected design surface, between two design surfaces, or elevation 
changes as different shades of blue depending on the setting of the 
radio button. 

The Coverage Grid function has three options:

 l Cut/Fill: Measured – This setting displays a coverage grid based 
on the current measurement within a grid point relative to the 
design surface selected in the Open Project screen as different 
shades of red, blue or green.  If there are multiple measured 
points within a grid cell, the largest cut/fill value is used in the 
color display.
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Select this 
option…

to display…

 l Cut/Fill: Surface A-B – This setting displays a static coverage grid 
map of cut/fill between two design surfaces.  Surface A is the 
primary design surface set in the Open Project screen.  Surface B 
is the secondary surface set through the Home / Settings / 
Second Surface.  This display is static and does not update based 
on any new measurements.  It can only be displayed between 
two existing designs saved in the Site.

 l Elevation – This setting displays the relative elevation of grid cell 
points as shades of blue.  Lighter shades of blue are lower in 
elevation than darker shades.  The color scale gradations are 
distributed evenly across the difference between the maximum 
and minimum measured elevations.  The colors automatically 
update if a new  elevation value is measured.

 l Grid Size – Using this setting the size of the coverage grid can be 
changed and set to a scale to meet the needs on site.

Point codes the point codes of every point on the map view.

Point cut/fill the cut/fill information for every point on the map view.

Stakeout points stakeout points on the map view.

Measured feature measurements that were recorded as a site feature.
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Map Options: Design tab
Use the Design tab to filter the different design data types that are displayed:

Select this option… to display…

Design the design map on the map view.

Guide arrow the guidance arrow to navigate to points of interest.

Roadway the center line of any roadway design.

Display cross-section display the slope values for each segment of a road cross section.

Project map the project map on the map view.

Stakeout flags stakeout flags on the map view.

Cross section lines the cross sections of any loaded roadway design.

Lightbar Sound an indicator sound when approaching the design elevation.

Design contours contours on the map view, if a design is loaded.

Contour interval sets the contour interval for the displayed design contour lines.

Stakeout guide sets the behavior of the fine stakeout guide bullseye when within 
2 m of a stakeout point.  North/Instrument Orientation will keep 
the stakeout guide oriented towards north for GNSS or as if 
facing the total station. Approach will orient the guide with “up” as 
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Select this option… to display…

in the direction of approach towards the point, when the guide 
appears at 2 m from the point.  Hide will not show the guide. 

Cut/Fill precision determines the number of decimal places displayed in the info 
bars on the map screen and for the Cut/fill of individual points if 
the Point Cut/fill is selected in the Measure tab.

Map Options: Layers tab
Use the Layers tab to turn individual or all layers on and off in the design map to improve 
readability if there is a lot of data in the current design DXF file.

To toggle on and off individual layers, select/deselect the check box next to their names.

To toggle on and off all layers, click Select/Unselect All Layers at the top of the screen.
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Map Options: Rotate tab
Use the Rotate tab to control the map rotation of the Measurement screen:

Select this option… to orientate…

Static the map view to North.

Travel direction the map view to your direction of travel/walking.

Follow alignment (This option is only available when an alignment is selected.)

Up station the screen up station.

Down station the screen down station.

NOTE – When any option other than Static is selected, a North arrow automatically appears on the 
screen.
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Map Options: Panel Display tab
Use the Panel Display tab to control what information is shown in each of the panels on 
the main screen:

Select this option… to orientate…

Plan View Displays the plan view in the chosen panel

3D Surface Viewer Displays the 3D surface viewer in the chosen panel

Information Panel Displays the information panel in the chosen panel

Lightbar Displays the lightbar in the chosen panel

Cross Section Displays a selected cross section in the chosen panel. 

eBubble Displays the eBubble in the chosen panel

NOTE – A Cross Section is only displayed if road or alignment data is loaded in the current design. 
This feature is only enabled for users with the Roading module who are able to load alignment or 
road data.
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Toggling between the panels
The main screen has three panels. The data in these panels can be set by selecting the 
main menu then Settings, Map Display Settings and selecting the Panel Display tab. 

Alternatively, a quick way to select the data shown in the top and bottom panel is by 
clicking on the down arrow icon:

The required data can then be selected from the menu: 

To display the data from the top and bottom side panels, select the panel switch icon in 
the bottom right of these small panels:

NOTE – The eBubble cannot be displayed in the main panel.
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Info bar
At the top of the screen is a bar that shows readings and values related to the current 
operation:

Use the arrows on the right and on the left to scroll through the different values which are 
currently enabled. You can also tap on the bar and "flick" through the different values. For 
each function, a predefined set of values is shown. You can modify the settings in the  
Home menu / Settings / Info Bar/Panel  under the information bar tab

The Information Panel changes what is displayed when the information panel is selected to 
be displayed in one of the panels on the main screen. 
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Some fields in the information bar(for example, Antenna & Target Height, Stakeout line 
offset, and Surface offset) are "active" fields. By tapping on it, you can change the settings 
and shortcut in the Settings dialog of this value. The active fields are indicated by white text 
on dark gray background.

The following values are available; those indicated with an * are the “active” fields:

This value Shows the…

Ant Ht * currently applied antenna height for GNSS.

Tar. Ht* currently applied target height for total station.

E current Easting in the selected/applied coordinate system.

N current Northing in the selected/applied coordinate system.

Elv current Elevation in the selected/applied coordinate system.

Horizontal angle current horizontal angle the instrument is shooting.

Vertical angle current vertical angle the instrument is shooting.

Slope distance current slope distance the instrument is shooting.

Lat current latitude in WGS-84.

Long current longitude in WGS-84.

Ht current height in WGS-84.
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This value Shows the…

Sta current station to a selected road or alignment.

Off current offset from a selected road or alignment.

Go distance and direction guidance to a selected point or object.

Cut/Fill cut/fill value to a selected design, road, or alignment.

Dsn Elv elevation of the selected design, road, or alignment at the 
location of the positioning instrument. 

Thickness current  vertical thickness of a layer from on the last layer.

R. Sta current station to the selected reference alignment  or line.

R. Off current offset to the selected reference alignment  or line.

dE difference in East to a selected point or object.

dN difference in North to a selected point or object.

dZ difference in Elevation to a selected point or object.

Ahead/Back difference in station to a selected point along the selected 
alignment.

Inward/Outward difference in offset to a selected point relative to the selected 
alignment.

Feature 2 cut/fill cut/fill value of the feature node that is created while staking a 
roadway feature using dual segments.

Feature 2 design 
elevation

design elevation of the second roadway feature created by the 
dual segments setting. 

Dsn Sta station to a selected point per design.

Stakeout line offset H* currently-applied horizontal line offset.

Stakeout line offset V* currently-applied vertical line offset.

Surface offset* currently-applied surface offset.

Cut/Fill A Cut/Fill values referenced to the primary surface.

Cut/Fill B Cut/Fill values referenced to the secondary surface.

Design Elv A design elevation referenced to the secondary surface.

Design Elv B design elevation referenced to the secondary surface.
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This value Shows the…

Cut/Fill between 
surfaces

distance between the primary and secondary surface at this 
location.

Second surface 
settings*

surface selection and offset options for secondary surface.

FXL code description for the selected feature code.

Antenna Height/Target Height

To change the antenna or target height, tap on the value in the info bar . This 
value is subtracted from each GPS elevation or elevation measured with a total station. If 
the antenna/target height is currently not displayed in the info bar, turn it on in the Home 
menu / Settings / Info Bar/Panel using the Information Bar tab.

Select whether a quick release is being used on compatible GPS receivers, but only enter 
the height to the bottom of the quick release as shown in the diagram. Siteworks 
automatically accounts for the height of the quick release and indicates its use on the map 
screen with an icon showing a quick release:

.

Each change of the antenna or target height and quick release use is stored in the log file, 
and can be viewed in the Work Order’s task log, or by pressing the Home Menu/ Data 
Management / Log.
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Sites, designs, and work orders

Avoidance zone settings

Creating and opening a work order in the field

Connected Community service

Point Manager

Trimble recommends that you use the latest version of the Business Center – HCE 
software to prepare the data to be used with the Siteworks software. The Business Center 
– HCE software incorporates the capabilities of the SCS Data Manager and Report Utility for 
multiple jobsite/controller management and generating work order reports. The correct 
file folder structure is automatically created, and quality assurance tools are available to 
ensure that all controllers are using the most recent data.

 

5
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Sites, designs, and work orders
All data for the software is stored in a top-level folder called Trimble SCS900 Data, and is 
organized in a precise structure. The file folder structure created on the office computer 
exactly mirrors the file folder structure on the controllers, which makes it easy to manage 
and archive data between the computer and the controllers. Data is organized by project. 
Within each project, data is divided into designs and work orders.

Work orders can be created directly in Siteworks or exported from the Business Center - 
HCE software. Creating a work order in Business Center - HCE allows for the assignment of 
the necessary design, surface offsets, measurement tolerances, instructions, coverage 
map grid size, and continuous measurement settings.  Keeping data organized in work 
orders allows for easy import and data management within the Business Center - HCE 
software.

Information on a controller is arranged in the following levels:

Level Description

Global Global information is used at all sites. It includes lists of feature codes 
and Geoid files, and software information such as last connected site.

Project Project information relates to all activities at the specified site. It includes 
control points, site calibration results, and background maps. Project 
information is always available.

Design Inside each project, a main Designs folder holds individual design 
folders that contain design data pertaining to the project. Design data 
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Level Description

relates to a particular phase of construction. Data stored at this level 
includes foreground maps, stakeout data, and design surface models.

Work Order Inside each project, a main Work Orders folder holds individual work 
order folders.   This is where the measured data, and any exported data 
are stored. 
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Importing and exporting point files with style guides
The Siteworks software enables you to import and export comma, tab, or semicolon 
delimited ASCII point files in the Siteworks default PNEZD, PENZD or in custom user-defined 
formats that are set by a style guide.

To import/export point files with formats other than the Siteworks default PNEZD or 
PENZD, you need to define a point file style guide. 

Style guides are saved in a PointStyleGuides.jsn file in the Trimble SCS900 Data folder. This 
.jsn file is portable between field controllers and is synchronized during a Trimble 
Connected Community sync.

In each window where a point file can be selected there is an option to select the style 
guide or create/edit a new one. Current windows where a point file can be 
imported/exported include: Importing control points during the site creation process, 
Importing a point file from the Data Management menu, and Exporting Measured data via 
a Custom Point File. The Siteworks default style guide is the standard PNEZD or PENZD 
format. The coordinate order of the Easting and Northing during import/export using the 
standard Siteworks default format is set in the Site Creation process.
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Select the Create/Edit Style Guide option. The Style Guide Definition screen appears:

Here you can configure various parameters of the file. The basics of style guides involve 
setting the style guide name, value separator (delimiter), file extension, if each column has a 
prefix and/or suffix, and then assigning a Siteworks data type to each column in the file.

Prefixes and suffixes can be defined by typing the optional value directly into the third and 
fourth column.  During import, anything listed in the prefix or suffix box for that data type is 
ignored, and only the alphanumeric values shown before or after the prefix/suffix are 
imported.  Exporting a point file using a prefix/suffix adds the respective prefix/suffix to the 
value being exported.  The Siteworks software cannot automatically recognize what the 
data types are based on the prefix or suffix; that information must be set up in the style 
guide.

To configure a style guide:

 1. Select the Create/Edit Style Guide option and enter a name for a new style guide. 
Alternatively, tap the magnifying glass to open an existing style guide to edit.

 2. Select the value separator (comma, semicolon, or tab) that delimits the columns of data 
in the source file. 

 3. The file extension will be written to the exported file name during an export, and 
provides a means to filter by file type during file imports. Only those files with matching 
file extensions will be shown in the select file window during import.

 4. To import files with different file extensions but otherwise with the same column 
format, select the All Files option in the Type screen. 
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 5. To define the data type for each column select it from the drop-down list, and enter the 
column where it resides in the source file. If appropriate, enter the prefix and suffix 
values to be added.

 6. To add an additional data type, tap +. To remove an existing data type, tap -.

NOTE – During a point import process, only the Point Name, Easting, Northing, Elevation, and Point 
Code are imported into the Siteworks software; all other fields in the file and associated style guide 
are ignored during import. An exported point file will contain all the attributes established and 
configured in the style guide. These attributes include: Antenna/Target Height, Date, Easting, 
Elevation, HA, Latitude, Longitude, Northing, PDOP, Point Code, Point Name, Slope Distance, Time, 
VA, and WGS Height. Also note that an exported file will contain column header names in the 
exported file.

Avoidance zone settings
You can use avoidance zones in the Siteworks software. To create the avoidance zone, use 
the Business Center - HCE software. In a CAD file, create closed polygons around the 
different zones and select them as avoidance zones in the site creation process. Business 
Center – HCE software will place the CAD file called *.avoid.dxf in the SCS900 Site folder. 

As you approach an avoidance zone, the software warns you audibly and visually:

 l Yellow = Inside the avoidance zone tolerance area

 l Red = Inside the avoidance zone

To adjust the tolerance for the avoidance zone, select the  / Settings / Avoidance Zone.
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Creating and opening a work order in the field
From the Home menu, tap Project Setup and then Change Project. After starting the 
software, you can select an existing project and work order to start with:

For each of these options, you can either decide to open an existing project, design, and 

work order, or create a new one. Tapping the plus  symbol  on the right side opens a 
screen with a number of fields where you can define the settings and add data files from a 
USB drive or from data already stored on the controller.
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CAUTION – Before taking a measurement or associating a design with the site, 
ensure that the distance units are correctly set. All files that relate to a single site must 
be stored and operated with the same units. Once a measurement is taken, or a design 
is selected, you cannot change the units.

When creating a site on the controller, you can import or measure a site calibration or use 
a published coordinate system from the coordinate system manager. After you select the 
Select coordinate system check box and tap Coordinate System, the software will list all 
supported coordinate systems.

To use a geoid for the first time, it must be exported from the Business Center - HCE 
software, and stored in the Trimble GeoData folder on the controller.
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A work order can include instructions for the person in the field, explaining what tasks to 
carry out. Work order instructions entered in the Business Center – HCE system will appear 
in this screen when selecting the work order. When creating a work order in the field on 
the controller, instructions can be entered in the instruction box:

Work orders should have a meaningful name to make it easy to identify them when 
multiple work orders are created for a particular project.

Measured points are saved within individual work orders. For example, if you are staking a 
building pad, the saved stakeout values are saved into the work order folder. Then when 
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measuring topo on the same site but in a different work order, the measured topo points 
will be in that different work order. Also, any data exported via the Home/ Data 
Management menu is placed in an Output folder in the associated work order folder to 
make it easier to separate work tasks and keep the associated data compartmentalized.
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Connected Community service
The Connected Community service includes the following services:

 l Wireless Data Synchronization to synchronize Siteworks data with the data stored on 
the Connected Community website.

 l IBSS (Internet Base Station Service) web service to receive base station corrections 
from the local base station through the Internet.

All these services are tied to the device ID that you need to purchase for the controller with 
a monthly TCC subscription.

Registering the controller
To use the controller with Trimble Connected Community (TCC) services, you must register 
the controller online in the Trimble Connected Community Device Manager of the user 
organization. 

 1. In the Siteworks software Home menu, select Data Management.

 2. Tap Community Settings .

 3. Enter the credentials and then tap ACCEPT. The Device ID is hardcoded and set to the 
serial number of the device.  The Device Name is set up the first time the credentials are 
entered and cannot be changed once set; that will be the name of the folder for the 
device’s data that appears on the TCC.
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You only need to do this once. You can also enter a work group for Wireless Data Sync 
to group multiple controllers of a company in a certain structure.

Wireless Data Sync
The Wireless Data Sync option enables Siteworks data to be synchronized with data stored 
on the Trimble Connected Community website, which eliminates the requirement to 
physically move data to and from the field by plugging the controller into a computer or 
using USB sticks. Data can be synced right from the field as long as an Internet connection 
is available to the controller via Wi-Fi or a cellular modem.

To manage the synchronization process, the following set of rules controls the dataflow to 
and from the Trimble Connected Community website.

File Type Currently on 
the Connected 
Community

Currently 
on the 
controller

Action

Work Order Download to the controller

Upload to the Trimble Connected 
Community service

Upload to the Trimble Connected 
Community service if the file size is 
different

Design Data Download to the controller

Upload to the Trimble Connected 
Community service

Download if the file size is different

Site Download to the controller

Upload to the Trimble Connected 
Community service

Download if file size is different
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File Type Currently on 
the Connected 
Community

Currently 
on the 
controller

Action

Calibration File
(*.DC & *.CAL)

Download to the controller

Upload to the Trimble Connected 
Community service

NOTE – If data that has been previously 
synced is deleted from TCC but remains on 
the controller, you will be prompted to 
delete it from the controller.

Ask when the file size is different

Field Control 
Point File
(*.field.csv)

Download to the controller

Upload to the Trimble Connected 
Service

NOTE – If data that has been previously 
synced is deleted from TCC but remains on 
the controller, you will be prompted to 
delete it from the controller.

Ask when the file size is different

Office Control 
Point File
(*.office.csv)

Download to the controller

Upload to the Trimble Connected 
Community service

NOTE – If data that has been previously 
synced is deleted from TCC but remains on 
the controller, then you will be prompted to 
delete it from the controller.

Download if the file size is different

FXL File Download to the controller

Upload to the Trimble Connected 
Community service

Ask when the file size is different
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File Type Currently on 
the Connected 
Community

Currently 
on the 
controller

Action

Report.txt,
Tasklog.txt 

Download to the controller

Upload to the Trimble Connected 
Community service

Upload if the file size is different

Site.ini, Site.xml,
Site.xml.schema 

Download to the controller

Upload to the Trimble Connected 
Community service

Do nothing

Trimble GeoData Download to the controller

Upload to the Trimble Connected 
Community service

Download if the file size is different

The software stores the designs and work order names that have been synchronized in a 
history file with every synchronization. If designs or work orders are deleted from the 
Trimble Connected Community service since the last synchronization, the Siteworks 
software will also delete the files from the controller and then proceed with normal 
synchronization rules from above thereafter. Deleted work order data from the controller 
is stored in an Archive folder on the TCC servers. If control point files and DC files have been 
deleted from TCC since the last synchronization, then the Siteworks software prompts you 
to delete the files from the device. Files selected for deletion will also be placed in an Archive 
folder on TCC to preserve a record of them.

The software facilitates two Control Point files in the site folder: a Field Control Point file, 
where all control points measured or typed in the field are stored; and one or more Office 
Control Point files. The following file naming conventions must be used:

 l Office Control Point File: [filename].office.csv

 l Field Control Point File: [filename].field.csv

The Office Control Point file cannot be edited in the field, however the Field Control Point 
file can. Using the Business Center – HCE software, the data manager can take the control 
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points from the Field Control Point file of one controller, move it to the Office Control Point 
file and then push the new Office Control Point file out to other controllers.

When a site is opened for the first time and the software cannot find a Field Control Point 
file, the software converts the name of the existing Control Point file selected during the 
site creation process, and applies the naming convention for the Field Control Point file. 
From that point forward, the software will ignore all other CSV files in the Site folder that are 
not tagged office or field. The synchronization with TCC will only include Control Point files 
that are marked as Office or Field Control Point files. The synchronization rules for the 
Office and Field Control Point file from above apply.
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Point Manager
To access the Point Manager, select Home / Data Management / Point Manager. Options 
will appear to select either the point manager, view/ edit control points, or to import 
control file. Select Point Manager. Use this feature to retrieve a list of all points in the 
currently loaded work order. Tap Edit, Add, or Delete to make changes to an existing point, 
add a new point, or to completely delete a point.

Columns can be sorted by clicking on the column name. Use the search box at the top of 
the window to search by Point Name and Point Code fields. Point types can be filtered to 

display only certain point types by selecting . Office control points, denoted by the * 
cannot be changed.

Tap Add to enter 1D, 2D, and 3D control points, and 2D and 3D Stakeout points.

To edit points, select a point and then tap Edit. You can change the point name, point code, 
elevation, and antenna/target height for measured points.  Click on the down arrow to the 
right of the data field to switch between elevation and antenna/target height. Northing and 
Easting values of measured points cannot be changed, but may be changed for non-
measured points that were added by key-in. If an FXL file and the Advanced Measurement 
Module are active, you can assign an FXL code to the point. FXL attributes cannot currently 
be edited for existing points; but they can be replaced with new information by tapping 
Select FXL Code.
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Clicking Previous or Next takes you to the previous or next point in the list according to the 
sorting set in the list view.  Unsaved changes will be prompted for saving before switching 
points.

Information about the point can be viewed by selecting the Point Information tab.
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Displaying cut/fill

Checking a grade/elevation

Checking material thickness

Measuring a surface or a feature

The Siteworks software is a site measurement tool that enables you to monitor earthworks 
and surface finishing operations. It enables construction contractors to measure material 
volumes, monitor and measure grade elevations  relative to the site design, determine laid 
material thicknesses, and to perform site measurement tasks such as measuring points, 
lines, and surfaces.

6
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Displaying cut/fill
A valid design containing a surface model must be loaded via the Project Setup menu for 
cut and fill values to be displayed. If the software is not in Measure mode, tap the Home 
button and then tap Measure. Walk anywhere on the design surface and view the current 
cut/fill to the design elevation on the Info bar, page 46. The lightbar can be displayed in any 
of the panels by clicking the down arrow in the bottom or top side panel.

This lightbar indicates whether the surface is in cut, fill, or on grade:

 l Blue = fill (below design elevation)

 l Red = cut (above design elevation) 

 l Green = on grade 

The lightbar can also be turned off/on in the Panel Display tab of the Map Options by 
selecting/deselecting the Lightbar check box.  The lightbar will blink when approaching 
within approximately 0.33 m or 1 ft of grade elevation.

Audio indicators also will also sound when within 0.33 m or 1 ft of grade:

 l A steady tone = on grade 

 l A slow beeping = below grade

 l A fast beeping = above grade

The lightbar sound can be turned off/on in the Design tab of the Map Options by 
selecting/deselecting the Lightbar sound check box.
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Checking a grade/elevation
Measure a surface point at a location where you want to view and record the difference in 
elevation between the design surface and the actual ground. As you move around, the 
values in the info bar at the top of the screen update with current values.

 1. If not in Measure mode, tap the Home button and then tap Measure.

 2. Tap the Measure button to record a surface point and the cut/fill value at that location. 

The software draws a colored grid box of the size that you specify in the Settings / Map 
Display Settings / Measure tab around every recorded point so you can easily view where 
data is missing, and determine areas of cut or fill.

Once a point is recorded, a colored box appears around it, showing it as in tolerance 
(green), cut required (red), or fill required (blue). The colors are shaded depending on how 
far away from grade they are.

To change the cut/fill tolerances:

 1. Tap the  and then tap Settings / Measure.

 2. Enter the required tolerances and then tap ACCEPT.

TIP – If a gray box appears, tap the zoom window icon and draw a box around the area of 
the gray box. Gray boxes appear when the map is zoomed out too far to see the colored 
boxes at the specified resolution.
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If no boxes appear, tap  from the toolbar on the right. Ensure that the Coverage Grid 
check box and the Cut/Fill: Measured option are selected.  You can also change the grid 
size. Note that if a too small grid size is entered, that will result in more than 600,000 grid 
cells being created over the site’s extents, then no grid cells will appear. In this case, 
increase the grid size.

Grid cut/fill color display values are graduated into four shades each of blue and red. These 
cut/fill display color intervals are set through the Home menu / Settings / Measure settings 
as shown below.

The Tolerance (Above/Below) value is how far above or below the design surface elevation 
the measured point can be to plot in a green, within tolerance color. The Cut/Fill display 
interval is the distance over which one color shade will be plotted. Different values can be 
set individually for the Cut and Fill display intervals, along with different individual Tolerance 
above and below values.
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Checking material thickness
The typical procedure for checking a material thickness is:

 1. Measure the existing surface before laying the material.

 2. Save the measured surface as a design.

 3. Create a new work order and then load the saved design as the active design.

 4. Lay the new material.

 5. Check the material thickness by measuring points on the laid material, after entering a 
surface offset value equal to the required thickness.

If the current material thickness is too thin, a blue square appears to show that more “fill” 
material is required.  If the current material thickness is too thick, a red square appears to 
show that material is required to be “cut” away. If the current material thickness is within a 
specified tolerance, a green square appears to show that no action is required.

 1. If not in Measure mode, tap the Home button and then tap Measure.

 2. Tap the Home button and then select Settings / Measure.

 3. Ensure that the measurement offset is enabled in this menu (you can change 
tolerances here too).

 4. Select the measure type icon in the main panel  and enter the required thickness 
as a vertical offset. Tap ACCEPT.

 5. Tap Measure  to record a point and the cut/fill value at that location.

As you move around, the values in the info bar at the top of the screen update; the 
thickness of the material is shown in the Thickness box. The Thickness in the info bar can 
be activated, if it is not displayed, by pressing the Home Menu / Settings  / Info Bar/Panel.

Once a point is recorded, a colored box appears around it showing whether it is within the 
tolerance range or whether more or less material is required.

TIP – If a gray box appears, tap the zoom window icon and draw a box around the area of 
the gray box. Gray boxes appear when the map is zoomed out too far to see the colored 
boxes at the specified resolution.

If no boxes appear, tap  from the toolbar on the right. Ensure that the Coverage Grid 
check box and the Cut/Fill: Measured option are selected. You can also change the grid 
size. 
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Note that if a small grid size is entered that will result in more than 600,000 grid cells being 
created over the site’s extents, then no grid cells will appear. In this case, increase the grid 
size.
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Checking cut/fill between two saved surfaces
It is possible to produce a grid display of the cut/fill between two saved design surfaces. 

Tap  to open the Map Options screen and select the Coverage Grid option of Cut/Fill: 
Surface A-B. Surface A is the primary design surface loaded in the Open Project menu, and 
Surface B is selected via the  / Settings / Second Surface. This displays colored cut/fill grid 
cells between the two surfaces using the color settings set via the  / Settings / Measure, 
Tolerance Above/Below and Cut/Fill Display Interval. 

If too small a grid size is entered, you are notified of the minimum grid size to produce a 
display grid.

TIP – If a gray box appears, tap the zoom window icon and draw a box around the area of 
the gray box. Gray boxes appear when the map is zoomed out too far to see the colored 
boxes at the specified resolution.
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Measuring a surface or a feature
 1. If the software is not in Measure mode, tap Home and then tap Measure.

 2. To open the Measure Type settings screen, tap the icon highlighted above on the right 
hand side of the main panel to choose between point, line, surface, and non-surface 
feature to be measured:

Lines are measured by selecting one of the Line tabs for New Lines or Existing Lines.  
Selecting Existing Line enables the selection of an existing line from a table and the 
continuation of measuring that line from the last measured end point along it.  Selecting 
New Line requires entering a Line Name, and choosing what kind of line type it is.  Line 
types that are included in the DTM surface measurement are Breaklines, Volume 
Boundaries, and Outer Boundaries.  Line and Area are not included in the DTM surface 
measurement.
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 3. You can also enter a point name (will be automatically incremented) and optional point 
code. The status bar icon changes depending on what kind of point or line you choose 
to measure:

Icon   Definition

Surface Point Elevation is used to create a terrain 
model.

Feature Point Elevation is not used to create a 
terrain model.

Feature Line or 
Area 

Elevation is not used to create terrain 
model.

Breakline, Volume 
Boundary, or Outer 
Boundary 

Elevation is used to create a terrain 
model.

To create an outer boundary, volume boundary, or surface points to add to an existing 
line, select the correct line type.  Once a surface is measured, you can save the surface as a 
design and then perform a material thickness check. See Checking material thickness, page 
71.
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To save the measured surface as a design:

 1. From the Home menu, tap Data Management.

 2. Tap Surface as Design  and enter a design name. 

 3. Choose whether to include measured, design, or no linework. 

 4. Select if you wish to merge the measured surface with the currently selected design 
surface.

 5. Tap ACCEPT to export the measured surface as a design.
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EZ Level command
This feature provides a simple and easy way to graphically display elevations on a site 
relative to an arbitrary benchmark that is measured as part of the EZ Level workflow.  This is 
a display and indicate-only feature and does not store any points or measurements. It is 
available for both GNSS and total stations.  It does not require a site to be calibrated for 
GNSS use, or a total station to be set up on a known point.  The intent of this feature is to 
provide a laser level-like workflow to quickly and accurately determine cut/fill values from 
an arbitrary EZ Level elevation relative to a measured benchmark elevation.

To open the EZ Level feature, tap the Measure Mode icon on the right side of the main 
panel or tap the  Measure and select EZ Level:

And then select EZ Level:

Alternatively, tap the Home menu / Measure and then select EZ Level.

Once in the EZ Level Settings screen, enter a benchmark elevation which is the reference 
elevation that you wish to measure. Enter an arbitrary value for the benchmark elevation 
or select the elevation of a control point from a list of control points by tapping the list icon: 
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The EZ Level elevation is the elevation value that is used to display the cut/fill values to on 
the EZ Level screen, and is relative to the arbitrary benchmark elevation. For example, if 
there is a benchmark at elevation 100, and you want to determine cut/fill values for a 
finished floor elevation of 103.5, you would place the rod on the benchmark at 100, enter 
103.5 for the EZ Level Elevation, and then measure the benchmark. On-screen values then 
indicate the cut/fill relative to the 103.5 EZ Level elevation. The current elevation is displayed 
in the center of the screen, between the two arrows, and the cut/fill values to get to the EZ 
Level elevation are displayed on the upper or lower arrows respectively.
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To re-enter the settings window to change the EZ Level elevation and/or measure a new 
benchmark elevation, tap SETTINGS.

Measuring with feature codes
NOTE – The Advanced Measurement module is required.

The software can use feature codes to record data on site. Create and customize the 
feature code library using the Feature Definition Manager of the Trimble Business Center - 
HCE software.

The feature code defines if a point, line, or breakline is measured. The following classes of 
feature codes are available:

Feature code class Definition

Point feature, but no surface feature.

Line feature, but no surface feature.

Point feature and surface point.

Line feature and breakline.

Feature contains optional or compulsory attributes.

The currently selected feature code and its class can be identified in the status bar. To 

select and manage feature codes in the field, tap .
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Select this option… to…

① filter by group or category.

② select a feature code. 

③ drag code to the Quick Select list.

④ select from the Quick Select list.

⑤ toggle to the Grid view.

To select a feature code, either tap on one of the buttons in the Quick Select list or select a 
feature code from the Grid view. The Grid view enables you to measure data without 
seeing the map.  Instead you have up to 34 codes to choose from with a single tap.

Both the Grid view and the Quick Select list selection enable you access feature codes 
quicker by filtering feature codes by group and category. Groups and categories must be 
defined in the Feature Definition Manager in the office.

A category is a class of related feature codes, for example, vegetation. For certain 
measurements or tasks, you might want to group feature codes from different categories 
into a group for faster access.

With each feature code, different attributes can be stored, which enables you to describe a 
recorded point or line with more information. Attributes need to be set up in the Feature 
Definition Manager and cannot be changed or created in the field.
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Different properties can be applied to each attribute, for example, if it is optional or 
compulsory to fill out this attribute, which values are required for this attribute, the 
permitted length of the text string that you can enter, or available items in a drop-down list.

Photos
Photos can be attached as an attribute using the internal camera of the controller or from 
photos imported onto the site controller.

The pictures are associated with the measured point and will be available to view in a 
Trimble Business Center project. Photo attributes are set up in the Feature Definition 
Manager.
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Volume and COGO
Review & Edit Data

Create Points/Arcs

Key In Roads

When collecting data in the field, it is useful to be able to review and edit your data. This 
section covers reviewing and editing any surface data you have measured, calculating new 
points and lines in the field, and calculating the volume from measured data.

 

7
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Review & Edit Data
Use this feature to delete points you may have incorrectly measured. You can also use this 
feature to calculate volumes of any surfaces that you have measured. 

It also enables you to display contours of the surface, which serves as a quick check that 
you have correctly collected data.

From the COGO menu, tap Review & Edit Data .

The Review and Edit Data screen has a list of icons on the left side, which represents all the 
available functions. These functions can also be accessed directly by pressing the help icon 
in the upper right of the screen.

Icon Description

Compute Volumes

Create Line/Boundary

Delete Point/Line

Generate Measured Contours

Compute Distance

Compute Total Distance, including the slope distance between 
two points

Compute Area

Compute Down and Out from Line

Compute Angle

Help

NOTE – The help icons are active and the associated task and workflow 
can be accessed by tapping on the icon. 

To undo an action, tap . To reset an action, tap .
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Compute Volumes
Use the Compute Volume option to calculate a volume from the data you have measured. 
Three types of volumes can be calculated:

 l To a design surface

 l To an entered elevation

 l To a surface created by the volume boundary (stockpile/excavation volume)

NOTE – You must have measured or created via the appropriate COGO functions a closed volume 
boundary around the area you wish to measure the volume of.

From the Review & Edit Data menu, tap Contour Measured Surface  to view contours 
based on the surface you have measured. This is a useful tool to check for any major 
errors in measurement that can then be adjusted via the relevant COGO commands. The 
contours highlight any elevation errors in the data. The software controls the minimum 
contour interval based on the elevation range of the measured data.

 1. In the Elv. Interval field, enter a contour interval and then press Enter.

 2. Tap the Compute Volume icon . 

 3. Tap on the boundary of the area for which you want to calculate the volume and then 
tap OK.

 4. Select the type of volume to compute:

 a. The volume from the surface you have measured to the design surface.

 b. The volume to a user-defined elevation.

 c. The volume of a stockpile/depression – this calculation uses a surface created from 
the measured line of the selected volume boundary.

 5. The following screens show the result of the volume calculation. An expansion or 
shrinkage factor can be entered to accommodate for material expansion or shrinkage.
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The results of the volume calculation are stored in the TaskLog.txt and can be reviewed 
using the name of the volume in the system log, accessed via Data Management / Log.
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Create Points/Arcs
Use the Create Points/Arcs option to create design data in the field. You can create new 
points relative to other points and lines in the work order or in the current loaded design. 

From the COGO menu, tap Create Points/Arcs .

A variety of functions are available in the bar on the left. These functions can also be 

accessed directly by pressing the help icon   in the upper right of the screen.

Icon Description

Create a radius point for an arc.

Create offset points from a line.

Create an offset point at a certain station.

Create a mid-point of a line or arc.

Subdivide a line or arc in segments.

Create a point at a distance and bearing.

Enter the coordinates of a stakeout point.

Create points at the end of a line or arc.

Free Point Pick.

Toggle display bar.

Create a point at the intersection of a line.

Deflection from Line

Delete points and lines.
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Icon Description

Create an arc from three points or two points and radius.

Create a circle by selecting a center point and either clicking or 
entering a radius or diameter.

Create a new line from two points.

Select points from a list

Define 2d object elevation

Access the Help.

NOTE – The help icons are active and the associated task and workflow 
can be accessed by tapping on the icon. 

Points can be stored as stakeout points or as measured points. A surface can be 
generated from measured points, which you can then export to the GCS900, AccuGrade, 
or Earthworks grade control systems for machine guidance through the Home / 
Import/Export / Export to Machine command.
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Key In Roads
This functionality is available to users who have purchased the Roading module.

From the COGO menu, tap Key In Roads .

A variety of functions are available in the bar on the left:

Icon Description

Create/edit a roadway alignment.

Create and position road templates.

Create stakeout points at a certain station and offset from the 
road alignment.

Create stakeout points at a certain station and with a deflection 
angle from the road alignment.

Change the Key In road entry method.
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Creating an alignment

Tap the Create/Edit Roadway alignment icon . A tabular entry screen appears to enter 
the geometry for the horizontal and optional vertical alignment.

Complete the numeric boxes to define it.

To convert a polyline of the current loaded design or work order in an alignment, tap Map.
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If roads already exist in the current design that were created in the Siteworks software, you 
are prompted to choose to edit an existing road or create a new one:

The following table shows the record types that the Siteworks software supports and the 
data that you must enter for each type. Depending on the Key In Road settings, the 
alignment can be entered via segments or via coordinates for the points of intersections. 
The POB is the Point Of Beginning, which is always the first record for a horizontal 
alignment and contains the start station and coordinates. The azimuth is always 
automatically computed and appears in the table as Tangent. If you tap on this field, the 
software displays the actual calculated azimuth. If required, you can overwrite it with your 
own value. You can also enter the azimuth as a bearing (that is, S 90 W = azimuth of 270°).

Record type Col1 Col2 Col3 Col4

POB (Point of 
Beginning)

Station Northing Easting  

Line Azimuth Length    

Spiral In Azimuth Direction Radius Length

Arc Azimuth Direction Radius Length

Spiral Out Azimuth Direction Radius Length

Combining Spiral Azimuth Length    
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The end station value appears as you enter the road details. Tap Map to see the plan view 
of the alignment you are creating:
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Creating a vertical alignment
Tap Next. The Create Vertical Alignment screen appears:

Complete the numeric boxes to define it.

This table shows the record types that the Siteworks software supports and the data that 
you must enter for each type. The POB is the Point Of Beginning, which is always the first 
record for a vertical alignment and contains the start station and elevation.

Record type Col1 Col2 Col3

POB (Point of 
Beginning)

Station Elevation  

Arc VPI Station Elevation Radius

Vertical VPI Station Elevation Length

Grade Break Station Elevation  

The final station value must be the same as the end station displayed in the previous 
Horizontal Alignment entry screen. Tap Map to see the profile view of the alignment you 
are creating:
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If there is no current design, you are also prompted to create a new Siteworks design.

The main create road screen reappears showing you the plan view of the alignment you 
have just created:
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Positioning and creating templates

Tap the position and then tap the create road template icon . The following screen 
appears:

Pick the required station for the template. The following screen appears which allows 
entering the template.
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Button Description

Code for the feature node you are about to enter.

Horizontal distance to the last feature node which was entered.

Vertical distance to the last feature node which was entered.

Create Feature Node with the entered values.

Slope values for the Cut tie.

Slope values for the Fill tie.

Delete feature node.

Copy the left side to the right side.

Copy the right side to the left side.

Import a previously entered template.

Export a previously entered template.

When you first enter this screen, you will be asked if the values apply for the right side or 
the left side of the road; the values are applied from the centerline.
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Tap Insert to see the edge of seal on the right side of the road on the cross section.

Copy the right side of the road over to the left side by tapping the copy template button. 
When the template is complete, tap Accept. Enter a name for the template and whether 
you want to store the template in a library that can be accessed from any site on the 
controller.

Using templates means you can easily recall them by tapping the import template button. 
Select a template from the list. The whole definition appears in the cross section view.
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You can view the templates either in plan view or cross section view at any station you 
want. You can also view the templates at stations between definitions. The Siteworks 
software transitions between the templates.

Creating stakeout points
Two COGO functions are available:

 l Create stakeout points at an offset from the alignment. This function can be used for 
any road, not just ones created in the Siteworks software.

 l Create stakeout points at an offset from the alignment at a deflection angle. For 
example, this can be useful where a drain crosses a road. This feature can be used for 
any road, not just ones created using the Siteworks software.
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Points

Stakeout Settings

Lines

Slope staking

Reference Line

Surfaces

Planes

Roads

The Siteworks software enables stakeout of points, lines, surfaces and roads stored in a 
design. You can access the Stake menu either through the Home menu, or by tapping and 
holding on items in the Measurement screen.

8

Trimble Siteworks Software User Guide | 98



Stakeout Workflow

Points
Before you can stake out points, the points must be part of the currently loaded work 
order. There are a number of ways to get points that were not measured in the field into a 
work order:

 l Enter the coordinates of the point using the Point Manager function.

 l Use the Create Stakeout Points COGO functions.

 l Import stakeout points during the project creation process.

 l Import a point file through the Home / Data Management / Point manager / Import 
Point File.

 1. From the Measurement screen, tap the Home button and then tap Stake.

 2. Select a point using the list at the top right of the screen and then select a stakeout 
point in the Points tab. Alternatively, select the point directly from the map (tap and 
hold and then select Stake Point from the pop-up menu). If there is more than one 
object available in this area, a list of different objects appears that you can select from.

The list puts different stakeout items into separate tabs; Point, Line, Road or Surface:

 3. If you need to calculate a stakeout point from design data, tap Home and use the 
functions in the COGO menu.

 4. Multiple stake methods (point, side slope, and catch point) are available. For 
information about slope staking, see Slope staking, page 108.
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 5. Use the values in the info bar (for example, GO) to navigate to the point. A small green 
arrow between your current position and the stakeout point provides you with 
guidance. In addition, a large arrow on the top right of the screen will point in the 
correct walking direction to the point after the software recognizes in which direction 
you are currently moving. When using a map rotation in travel direction or following a 
selected alignment, an additional North Arrow on the top left indicates North so that 
the values in the info bar can be used to navigate to the point.

 6. When you are close to the stakeout point, the software switches into the Fine Stake 
mode. Additional guidance arrows appear on the top right corner of the map to 
indicate the remaining distance in each direction.  

 l When staking with a GNSS, the fine navigation arrows will be displayed in a north 
"up" orientation  or the direction of approach when the fine navigation arrows 
appear, depending on the setting of the Stakeout Guide in the Design tab of the 
Map Options screen. 

 l For staking performed with a total station, the fine navigation arrows will be 
oriented depending on the connection method to the total station.  

 l For Bluetooth and cable connections, the directions will be as if you were standing 
behind the total station looking towards the point. 

 l For radio connections, the directions will be as if you were standing at the prism 
pole looking towards the total station.

 7. Once you are within horizontal tolerance (set via the Home Menu / Settings / Stakeout), 
the dot in the circle of the stake guidance turns yellow.  After tapping the Measures 

button , a stakeout report for this point appears. The software remembers which 
tab of the stakeout report was last viewed and opens the same tab after staking the 
next point.

 8. Select the Edit stakeout name check box to store the staked point using a different 
point name and point code.

In another tab, a graphical diagram shows how to put an elevation mark on the stake. 
The software does all the calculations for you. The way that the software calculates the 
elevation mark and cut/fill depends on the stakeout settings in the Stake Marking 
Method settings in the Home Menu / Settings / Stakeout.

 9. After the stakeout of the point has been completed, the software returns to the 
Stakeout Selection screen. If during the stakeout process a different point is required, 

tap the Home menu and then tap Change Stake Object .
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 10. To change the stakeout elevation to a different value, tap the Home menu and then tap 

Stakeout Elevation .
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Stakeout Settings
To access these settings, from the map screen, select the  menu and then tap Settings / 
Stakeout. The software supports three elevation reference methods used to mark cut 
depths or fill heights on a grade stake or location/grade stake:

 l Measuring the cut/fill reference mark from the ground surface

 l Measuring the cut/fill reference mark from the top of the stake

 l Cut/fill reference from the measured point

These methods help you to establish a cut/fill reference mark on the stake at a specified 
cut/fill measurement interval, such as at one-foot increments. If you choose to place a 
cut/fill reference mark on the grade stake, a Stake Marking report helps you establish the 
position of the reference mark on the stake and helps you correctly label it.

Typically, you will use one of the above methods consistently. Usually, you use only one 
method. When you first receive the software, switch to the correct setting. The software 
then uses that setting for all stakeout operations. When you tap Measure during a 
stakeout operation, the software converts the measured elevation, design elevation, and 
computed cut depth or fill height into information that you can then write on the stake. It 
also informs you where to mark the stake based on the settings that you enter in this 
dialog:

The stakeout tolerance is also entered in this dialog. 
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Measured Point
This method enables you to label a grade stake with the required cut depth or fill height as 
measured from the measured point, which can be either the top of stake or the current 
ground surface. If you choose to mark the stake with the cut depth or fill height as 
referenced to the measured point, the software simply informs you of the direct cut or fill 
measurement from that point. In this case, you can mark that measurement on the stake, 
using your normal convention to indicate from where the measurement is referenced.
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Ground Surface
With this method, the software guides you to the horizontal location of the stakeout point. 
The software generates a Stake Marking report that shows the distance from the ground 
up to where you must mark the stake. It also shows the value of cut or fill to mark on the 
stake.
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Top of Stake
With this method, the software guides you to the horizontal location of the stakeout point. 
You then hammer the stake into the ground and measure the top of the stake. You can 
change the antenna height for this measurement in case you want to take the receiver off 
the pole and place it directly on the stake. The software shows the distance from the top of 
the stake down to where you must mark the stake. It also shows the value of cut or fill to 
mark on the stake.

Lines
The lines you want to stake out must be part of a design map in the currently loaded 
design. There are multiple ways to get lines into a design, in addition to measured lines:

 l From a DXF foreground map with lines created in the Business Center - HCE Software.

 l By creating lines from points using the COGO functions

 1. From the Measurement screen, tap the Home button and then tap Stake.

 2. Select a line using the list at the top right of the screen and then select a stakeout line in 
the Line tab. Alternatively, to select a line directly from the map, tap and hold on it. If 
there is more than one object available in this area, a list of different objects appear 
where you can specify your selection. When using the Business Center - HCE software, 
names can be assigned to lines, which improves the orientation.
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You can also create a new line from points in your loaded design or work order by 
tapping the New line icon in the top right corner of the screen:

 3. If necessary, before confirming the selection, change the line direction using the  
button on the top right of the screen. This function is not available for lines selected by 
tap and hold.

 4. Different stake methods (side slope and catch point) are available. See page 108.

 5. Enter the station to be staked out or tap on the line where you want to stake it and 
then tap ACCEPT. To change the settings related to the line staking, such as desired 
horizontal and vertical offsets, stakeout elevations, station advancement interval and if 

corner/tangent points should be created, tap .

 6. The map view then guides you to the point. To help you find the point, the guide arrow 
in the upper right side needs to point up the screen to show that you are traveling 
directly toward the point. You can turn the guide arrow off and on in the Design tab of 

the Map Options dialog, accessed by tapping . The information bars at the top of 
the screen can be customized using the Info Bar/Panel option.  The display shows the 
design elevation for the point, the amount of cut or fill required to get to that elevation, 
and how far and in what direction you need to travel to get to the point.

 7. The default map view has the direction north pointing up. You can change this so that 
the guide arrow is pointing in the direction you are walking by changing the map 
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rotation in the Map Options dialog. It is recommended to turn on the cut/fill lightbar in 
the top or bottom panel on the left to graphically show the cut and fill.

 8. When you are close to the selected line point, the software switches into the Fine Stake 
mode. Additional guidance arrows appear on the top right corner of the main panel to 
indicate the remaining distance in each direction. The screen is oriented to the last 
moving direction before the Fine Stake mode was activated if map rotation in travel 
direction was selected. 

 l When staking with a GNSS, the fine navigation arrows will be displayed in a north 
"up" orientation or in the direction of approach at the time the fine navigation 
arrows appear. Set this Stakeout guide option in the Design tab of the Map 
Options screen.

 l For staking performed with a total station, the fine navigation arrows will be 
oriented depending on the connection method to the total station. The direction of 
the fine stakeout guide will be in the direction of approach when the fine navigation 
arrows appear if Approach Orientation is selected. If North/Instrument 
Orientation is selected, the behavior will be as outlined below.

 l For Bluetooth and cable connections, the directions will be as if you were standing 
behind the total station looking towards the point. 

 l For radio connections, the directions will be as if you were standing at the prism 
pole looking towards the total station.

 9. After tapping Measure, a stakeout report appears. The software creates a Stake 
Marker report. A graphical diagram shows how to put an elevation mark on the stake. 
The software does all the calculations for you. The way the software calculates the 
elevation mark and cut/fill depends on the stakeout settings in the Trimble icon menu. 
The software remembers which tab of the stakeout report was last viewed and opens 
the same tab after staking the next point.

 10. Instead of staking a certain station it is also possible to stake a line at random stations 
using the buttons on the  status bar on the right side of the main panel:

Tap... to...

stake at fixed station intervals starting at a certain station.

stake at random and arbitrary station intervals anywhere along the 
line,  based on your current station location perpendicular to the line. 

NOTE – The fine stakeout guide arrows will not appear when in random 
mode.
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Settings available for staking lines include options to enter a horizontal and vertical offset 
for the stakeout line. The line elevation can be defined using different methods and the 
start station, station interval (increment distance), and whether or not to automatically 
advance to the next station can also be determined. If a horizontal offset is applied and yes 
is selected in the Create tangent/corner points selection menu, three stakeout points are 
created at each corner to help you stake out the lines. Access these settings from the 

Home menu under Stake/ Line settings or by tapping the Line Settings button  on 
the Select Line Station selection screen or in the top left of the main panel.

Slope staking
For both stakeout point and stakeout lines, side slope and catch point stakeout modes are 
available that enable staking out the slope or the catch point between this slope and the 
existing ground. This function can be applied to any earthwork operation that involves a tie 
to the current ground surface. Examples include staking earthworks for pad placement, 
earth dams, site drainage, ponds, lagoons, embankments, and keyways.

The tie-slope can be projected from a 3D point using a bearing or from a 3D Line. After 
defining either one of those, the stakeout process is very much alike. Tap on the stake 
mode icon on the bottom of the status panel on the right side of the main panel:

You can then select line, side slope or catch point. Use the Define Side Slope dialog to 
select the direction of the slope and whether you define a cut and/or fill side slope to the 
left or right of the reference line. To select what the slope designation is to be based on, 
alter the selection in the Slope direction field.
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The software computes the elevation of the reference line at that point, and projects the 
designated cut and/or fill side slope magnitudes from that reference point, through your 
position, along a line referred to as the slope indicator. The slope indicator line is shown in 
the map view, extending from the reference line to the currently predicted catch point 
location. In predicting the location of the catch point, if you have defined both cut and fill 
slope magnitudes, the software determines whether the cut slope or fill slope is applicable 
at the reference point.

When staking building pad side slopes, the building pad has both internal and external 
right-angled corners. If you are staking external corner points, then the software 
automatically calculates the side slope as projected radially from the corner point. At an 
internal corner, the software calculates the catch point at a bi-sectional angle.

The Catch point option enables you to stake out points where the side slope intersects the 
ground surface as it is found to exist. As you stake catch points at fixed intervals, you 
should adapt to the existing terrain and be aware of the effect that it may have on the 
location of the daylight line. You can freely switch between the Stake at fixed intervals mode 
and Stake at randomly chosen interval modes.

The Line option enables you to stake out the side slope’s reference line. The software 
guides you to the line at the nearest point to where you currently are, or to a specific 
station. The Side Slope option enables you to place a grade stake at any required location 
on the side slope between the reference line and the catch point. You can toggle between 
the different stakeout methods by selecting the icon at the bottom of the status bar on the 
right side of the main panel.:
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Icon Description

Stake catch point

Stake side slope

Stake line

Reference Line
While staking out different objects like a point, line, surface or road, a separate line or 
alignment can be selected and referenced to record the station and offset values relative 
to the reference line in the stake record. To select a reference line or alignment, go the 
Main Menu / Settings and then tap Reference Line. Select the reference line from the map. 
Alternatively, tap and hold on a line you want to select as the reference line, and choose 
Select as Reference Line from the pop-up menu.

When a line is selected to be used as a reference line, an optional horizontal offset and a 
line start station can be applied.

The station and offset to this reference line can be displayed in the info bar as reference 
station (R. Sta) and reference offset (R. Off) while staking the actual object. To deselect the 
reference line, return to the Reference Line in the main menu / Settings and then click on a 
blank area of the map screen. Alternatively, tap and hold on the original line (not the 
reference line) and choose Unselect Reference Line.
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Surfaces
Use the Stake Surface feature to put grade stakes over a design surface indicating the 
cut/fill to it. The surface you want to stake out must be in the currently loaded design. 
There are multiple ways to get a surface into a design:

 l From an imported TTM surface file (this can be created in the Business Center - HCE 
software).

 l By creating a surface design from an existing Siteworks work order measured surface 
points and lines, using the Data Management / Surface as Design feature.

 1. From the Measurement screen, tap the Home menu and then tap Stake.

 2. Select the surface using the list icon  on the top right of the screen and then in the 
Surface tab select a stakeout surface.

 3. Use the values in the display bar to indicate the current cut/fill of the surface.

 4. After tapping Measure, the software creates a Stake marker report. A graphical 
diagram shows how to put an elevation mark on the stake. The method that the 
software uses to calculate the elevation mark and cut/fill depends on the Stakeout 
Settings in the / Settings / Stakeout.
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Planes
Use the Stake Plane feature to define a plane similar to how a grade laser works and then 
use a GNSS or a Total Station to get an indication of the resulting cut/fill between the 
current position and the plane. There are three options to create a plane to stakeout:

 l Level Plane – Choose an elevation to define the level plane.

 l Sloping Plane – Choose an origin point and elevation, a main slope, and an optional 
cross slope. 

 l Three Point Plane – Create a plane from three points.

 1. From the Home menu, tap Stake. This command is also accessible in the main panel by 
clicking on the icon shown below.

 2. On the top right corner of the Stake Object screen, tap the Define Plane icon . The 
Define Plane dialog appears:

 3. Select and configure the plane you want to stake.

Level plane is a flat surface with a defined elevation; sloping plane is defined by an 
origin point, main slope, and cross-slopes; three-point plane is defined by picking or 
measuring three points.

 4. To save the specified plane as a design, select the Save Plane as Design check box and 
enter a name into the Name field. The plane will then be available in the site’s Design 
folder and available for loading through the Project menu or loaded as a second 
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surface.

 5. Use the values in the display bar to show the current cut/fill of the plane.

 6. To record a point and view the stakeout report, tap the Measure icon in the main 
panel.

Roads
The road or alignment that you want to stake out must be part of the currently loaded 
design. These files are saved as .PRO files. There are multiple ways to get a road into a 
design:

 l From a road corridor created in the Business Center – HCE software and exported 
through the Field Data menu.

 l Convert LandXML files with the SCS Data Manager.

 l Export a road from the Terramodel® software.

If you have the Road module installed and a Road design loaded, you can select a 
road/alignment from the map by tapping and holding on it, or from the list in the Stake 
menu and then selecting one of the three road staking methods that are available:

 l Roadway feature staking(see Roadway feature staking, page 115)

 l Catch point staking(see Catch point staking, page 122)

 l Location on Surface(see Location on Surface, page 125)

If no Roading option is installed on the controller, a warning appears.

Roadway segment staking
The grade stake marking preferences in the Stakeout Settings dialog also apply to staking 
roadways. Staking methods for catch point staking can be determined in the / Settings 
under Catch Point Stake Settings.

 1. From the Measurement screen, tap the Homemenu and then tap Stake.

 2. Select a road or alignment using the list at the top right and then selecting an 
alignment in the Road tab. Alternatively, select an alignment directly from the map by 
tapping and holding. If there is more than one object available in this area, a list of 
different objects appears where you can specify the selection.

 3. Enter a station or select one from the map at which to stake out the road feature. To 
change the settings related to the road staking, such as the desired subgrade offset, 
station advancement interval, what tangent points to automatically stop at, guide line 
offset, and the view settings, tap 
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.

After selecting the station, a cross section of the roadway appears. It notes the location 
of each roadway feature as a node on that cross section. The Select Roadway Feature 
screen appears.

 4. Select the roadway feature node that represents the roadway feature that you want to 
stake out. To select a node, do one of the following:

 l Select from a node list (tap the list icon in the top right corner).

 l Tap the required node.

If the node is on the finished grade model, the name of the node would be SHLD, for 
example. If the node being selected is on the subgrade adjusted surface, it would be 
named SHLD-0.250; meaning it is the SHLD node, but it has a -0.250 m offset. To enter a 

subgrade offset, either tap  or access the road settings by selecting Settings / 
Roads.

If you are navigating up station, the normal cross-section view is displayed left to right 
as expected. If however, you are navigating down station, then the cross section would 
normally be back to front. To reverse the view of the section, change the view setting to 

up station or down station entered by either tapping  or accessing the Road 
Settings by selecting Settings / Roads.

 5. Let the software guide you to the point to be staked on the selected feature using the 
values in the info bar. To help you find the point, the guide arrow needs to point up the 
screen to show that you are traveling directly toward the point. You can turn the guide 
arrow off and on in the Design tab of the Map Options screen. The information bars at 
the top of the screen can be customized using the Customize info bar option in 
Settings / Info Bar/Panel.  By default, the info bar shows the design elevation for the 
point, the amount of cut or fill required to get to that elevation, and how far and in what 
direction you need to travel to get to the point. You can scroll through the different 
values using the grey arrows on either side of the info bar or “flick” the menu. The 
default map view has the direction north pointing up. You can change this so that the 
direction you are walking is pointing at you by changing the map rotation the Rotate 
tab of the Map Options screen. It is recommended to turn on the  cut/fill lightbar and 
the Cross Section in the top or the bottom panel on the left of the main panel. The 
lightbar will graphically show the cut and fill.

 6. When you are close to the required line point, the software will switch to the Fine Stake 
mode. The design map will be overlaid by guidance arrows to indicate the distance in 
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each direction. The screen is orientated according to the map rotation settings in the 
map options function.

Once you are within tolerance, the  center of the guidance arrows will become solid 
yellow. After tapping Measure a stakeout report appears, indicating the storyboard 
items that can be written on the stake. A graphical diagram indicates how to put an 
elevation mark on the stake.  The method that the software uses to calculate the 
elevation mark and cut/fill depends on the Stakeout Settings in the  / Settings/ Stakeout.

 7. Instead of staking a certain station, you can also stake an alignment at random stations 
based on the location perpendicular to the centerline of the alignment, using the 
buttons on the bottom right in the status bar.

Roadway feature staking
 1. From the Measurement screen, tap the Home menu / Stake.

 2. Select a road or alignment using the list at the top right of the screen and then select 
an alignment in the Road tab.  In the Stake Method drop-down menu select Feature 
and click ACCEPT. 

 3. Enter a station or select one from the map at which to stake out the road feature. The 
Select Roadway Feature screen appears. A cross section of the roadway  notes the 
location of each roadway feature as a node on that cross section. 

 4. Select the roadway feature node that represents the roadway feature that you want to 
stake out. To select a node, do one of the following:

 l Select from a node list (tap in the top right corner).

 l Tap the required node.
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If the node is on the finished grade model, the name of the node would be ER, for 
example. If the node being selected is on the subgrade adjusted surface, it would be 
named ER-0.250; meaning it is the ER node, but it has a -0.250 m offset. A subgrade can 
be entered by accessing Road Settings through Settings/ Roads or by tapping the 
Road Settings icon in the upper right side and entering a subgrade offset value.

If you are navigating up station, the normal cross section view is displayed left to right 
as expected. If however, you are navigating down station, then the cross section would 
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normally be back to front. To reverse the view of the section, select the Home menu / 
Settings/ Roads, and change the view setting to up station or down station.

 5. Let the software guide you to the point to be staked on the selected feature using the 
values in the info bar. To help you find the point, the guide arrow needs to point up the 
screen to show that you are traveling directly toward the point. You can turn the guide 
arrow off and on in the Design tab of the Map Options screen. The information bars at 
the top of the screen can be customized using the Info Bar/Panel option in the Home 
menu / Settings.  By default, the info bar shows the design elevation for the point, the 
amount of cut or fill required to get to that elevation, and how far and in what direction 
you need to travel to get to the point. You can scroll through the different values using 
the gray arrows on either side of the info bar. The default map view has the direction 
north pointing up. To change this so that the direction you are walking is pointing at 
you, change the map rotation in Map Options screen. You can turn on a cut/fill lightbar 
in the top or bottom panels on the left to graphically show the cut and fill.

 6. When you are close to the stakeout point, the software switches into the Fine Stake 
mode. Additional guidance arrows appear on the top right corner of the map to 
indicate the remaining distance in each direction. The screen is oriented to the last 
moving direction before the Fine Stake mode was activated if map rotation in travel 
direction was selected. 

 l When staking with a GNSS, the fine navigation arrows are displayed in a north "up" 
orientation or based on the direction of approach when the fine stake arrows first 
appear. Change this behavior with the Stakeout Guide option in the Design tab of 
the Map Options screen.

 l For staking performed with a total station, the fine navigation arrows are oriented 
depending on the connection method to the total station. 

 l For Bluetooth and cable connections, the directions are as if you were standing 
behind the total station looking towards the point. 

 l For radio connections, the directions are as if you were standing at the prism pole 
looking towards the total station.

 7. After tapping the Measure icon, a stakeout report appears. The software creates a 
Stake Marker report, including the Cross-Section Storyboard to write on the stake in 
the Report tab.  A graphical diagram shows how to put an elevation mark on the stake. 
The software does all the calculations for you.  The way that the software calculates the 
elevation mark and cut/fill depends on the stakeout settings in Settings/ Stakeout. The 
software remembers which tab of the stakeout report was last viewed and opens the 
same tab after staking the next point.
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Instead of staking a certain station, you can also stake an alignment at random stations 
using these buttons on the bottom right of the status bar:

Tap… to…

stake at fixed intervals starting at a certain station.

stake at random intervals somewhere along the alignment, based on 
the perpendicular location from the centerline.

 8. Set the Auto advance option field to one of the following options using the Road 

Settings dialog in the Home menu / Settings / Roads or by tapping :

To… select…

automatically move 
to the next station

To next station.

automatically move 
to the previous 
station

To previous station.

manually move to 
the next or previous 
station

No.

This option maintains the current station between points, and 
enables you to increase or decrease the station when you are 
ready.

not move a station Depending on the settings for Station Interval, the Siteworks 
software will or will not advance to the next station.

 9. To set whether the next auto-advanced station will be on a tangent point in the 
Horizontal and/or Vertical Alignment of the roadway, in the Tangent Point option, 
select

To… select…

stop at Horizontal tangent points Horizontal only.

stop at Vertical tangent points Vertical only.

stop at Horizontal and Vertical tangent points Horizontal and Vertical.

not stop at any tangent points None.
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Simple feature offset
When staking a feature, an offset is usually applied. The software is extremely flexible in the 
way that it enables you to specify an offset.

After selecting roadway feature node  (see Step 4 in Roadway feature staking, page 115) tap 
the button with the stake and the two arrows (roadway feature offset icon) on the top right 
of the screen:

. 

The Select Roadway Feature Offset screen appears. The second line enables you to 
specify the fixed horizontal offset or select a random horizontal offset. When specifying a 
fixed offset, a red line and a circle shows you where that offset point is. When specifying a 
random offset, you can stake anywhere along the cross section; the software displays the 
results to the point you are at:

 l The third line enables you to specify the kind of offset you want to use from the choices 
of Define Grade, Select Adjacent Segments, Select Dual Segments. Define Grade 
enables you to specify a slope for the offset. A grade of 0.000% is horizontal.

 l The  stake icon  on the top right side of the screen enables you to apply the offset 
from a different feature node instead of the selected feature node itself.
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Custom feature staking
Instead of staking a roadway feature node, you can define your own custom feature on a 
cross section. One example could be where the subgrade intersects with the tie slope. 
Follow these steps:

 1. While in the Select Roadway Feature screen, select the Define Custom Feature option 
from the drop-down menu:

 2. Select two feature nodes that will form the subgrade. You can access subgrade 
adjustments of the finished grade from the map view during stakeout or by tapping on 
the Road Settings gear icon in the upper right side of the screen (access the Road 
settings through Settings, and then enter the amount and direction for the offset).

 3. Select a segment (e.g., the tie slope). If required, enter a vertical offset for this segment 
and if you want to apply the offset vertical or perpendicular.

 4. A green circle stake location appears where this subgrade intersects the tie slope. 
Stake out this point as usual. You can also specify a horizontal offset for the stake the 
same way as a normal roadway feature.
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Custom segment staking
Instead of staking a roadway feature node, you can define a custom segment on a cross 
section. A segment is defined as the surface between two roadway feature nodes with an 
optional offset to reflect a subgrade. One example could be where a dam of a road gets 
built in multiple layers without having the complete shape of the finished grade. With this 
layered lift function, you can do the following:

 1. While in the Select Roadway Feature  screen, select the Define Custom Segment 
option from the drop-down menu.

 2. Select two feature nodes that will form the subgrade. If required, enter a vertical offset 
for this segment and if you want to apply a vertical or perpendicular offset.

 3. You will get guidance to the first point you have selected. Stake out this point as usual. 
You can also specify a horizontal offset for the stake the same way as for a normal 
roadway feature.  You can also enter a random offset and apply the grade of the 
roadway and then stake this layer infinitely to the left or to the right and get the cut/fill 
to this segment.
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Catch point staking
Catch point staking from the Road menu operates in an almost identical way to the catch 
point staking associated with the side slope function. The only difference is that the tie 
slopes are defined in the road model itself, and are automatically displayed. In a typical 
road model, there are at least two tie slopes; one for the right and one for the left side of 
the road. In the case of a divided highway, it is common to find four tie slopes, one for the 
left and right of each of the two traveled ways.

 1. From the Measurement screen, tap the Home menu and then tap Stake.

 2. Select a road using the list at the top right of the screen and then select an alignment in 
the Road tab. Alternatively, select the road alignment directly from the map or by 
tapping and holding and selecting a roadway from the pop-up menu. If there is more 
than one object available in this area, a list of different objects will appear where you 
can specify a selection.

 3. Select a stake method catch point and click accept.

 4. Enter a station or select one from the map at which to stake out the road feature. A 
cross section of the roadway appears unless no tie slopes were defined for this cross 
section. You can then choose to extend the outer segments of the road and use them 
as tie slope instead. Other options include defining a tie slope or choosing another 
station with tie slopes.

 5. Select if you want to stake the tie slope of left or the right side of the road by tapping on 
the tie slope itself or using down arrow on the top right. The selected tie slopes as 
defined in the road model (a cut slope shows in red and a fill slope shows in blue) will be 
highlighted.
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In the top line of the display, the roadway that the tie slope is associated with is 
displayed. In the example above, there is only one roadway in the selected road job, 
and that was not named—hence Roadway 0 is displayed.

You can redefine the current tie slope while you are staking out. For example, the 
design may specify a 1:3 cut, but when you stake it out you find that the point is outside 
the site limits, so you change the tie slope to a 1:2.5 cut. You can also project the tie 
slope from any node on the cross section.

From the list, select one of the following options:

 l Original cut/full

 l Key-in cut/fill (%) – Enter the new value and then select the node to apply it from

 l Key-in cut/fill (rise:run) – Enter the new value and then select the node to apply it 
from

 l Key-in cut/fill (run:rise) – Enter the new value and then select the node to apply it 
from

 l No cut/fill tie – If you select this option, the tie slopes disappear

It is also possible to offset the hinge point by clicking the stake icon on the top right of 
the screen.

 6. Navigate to the correct station using the Ahead/Backward values in the info bar. Then 
toggle the cross section view using the bottom icon in the map control bar and walk 
toward the tie-slope you are going to stake.

 7. The software calculates the intersection between this recreated surface and the tie-
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slope and provides you with guidance to this point by extending this surface toward 
the slope. This point is dynamic and changes depending on the way you walk and how 
the terrain is formed. Use inward/outward to find the actual catch point, but also keep 
an eye on the station.

Once you are in proximity of the point where the tie-slope intersects with the existing 
ground, tap the Measure icon.

The software creates a Stake Marker report. A graphical diagram shows how to put an 
elevation mark on the stake. Depending on the settings for catch point marking in the 
Home menu / Settings/ Catch Point marking, you will get guidance to one or two more 
stakes which mark the point. Single Stake, Dual Stake, and Batter Rail methods are 
available. The placement and marking of these stakes is completely guided. The 
software remembers which tab of the stakeout report was last viewed and opens the 
same tab after staking the next point.

 8. Instead of staking a certain station you can also stake a line at random stations using 
these buttons on the bottom right in the status bar:

Tap… to…

stake at fixed intervals starting at a certain station

stake at random intervals somewhere along the line
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Location on Surface
Location on Surface is a very basic method of staking a road. You can walk over the road 
surface and have the display showing station, offset, and cut/fill to this road surface or 
navigate to a certain station and offset of this road.

 1. From the Map screen, tap Home / Stake.

 2. Select a road using the list at the top right of the screen and then select an alignment in 
the Road tab. Alternatively, select the road alignment directly from the map. If there is 
more than one object available in this area, a list of different objects will appear where 
you can specify the selection.

 3. Select Location as the stake method from the drop-down menu and tap ACCEPT.

 4. Enter a station and offset into the boxes or select one by tapping a location on the 
screen. You can also overwrite the design elevation at this station by selecting Custom 
Elevation by tapping the down arrow in the upper left side of the screen.

 5. The map view then guides you to the point. To help you find the point, the guide arrow 
needs to point up the screen to show that you are traveling directly toward the point. 
You can turn the guide arrow off and on in the Design tab of the Map Options screen. 
The information bars at the top of the screen can be customized using the Configure 
Info Bars option in Settings/ Info Bar/ Panel.  The display below shows the design 
elevation for the point, the amount of cut or fill required to get to that elevation, and 
how far and in what direction you need to travel to get to the point. The default map 
view has the direction north pointing up. You can change this so that the direction you 
are walking is pointing up by changing the map rotation in map options. A cut/fill light 
bar can be turned on in the top or bottom panels on the left to graphically show the 
cut and fill.

 6. When you are close to the selected line, the software switches into the Fine Stake 
mode. Additional guidance arrows appear on the top right corner of the map to 
indicate the remaining distance in each direction. The screen is oriented to the last 
moving direction before the Fine Stake mode was activated if map rotation in travel 
direction was selected. 

 l When staking with a GNSS, the fine navigation arrows are displayed in a north "up" 
orientation.

 l For staking performed with a total station, the fine navigation arrows are oriented 
depending on the connection method to the total station. 

 l For Bluetooth and cable connections, the directions are as if you were standing 
behind the total station looking towards the point. 
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 l For radio connections, the directions are as if you were standing at the prism pole 
looking towards the total station.

 7. After tapping the Measure icon, a stakeout report appears. The software creates a 
Stake Marker report. A graphical diagram indicates how to put an elevation mark on 
the stake. The software does all the calculations for you. The way the software 
calculates the elevation mark and cut/fill depends on the stakeout settings in the Home 
menu. The software remembers which tab of the stakeout report was last viewed and 
opens the same tab after staking the next point.

 8. Instead of staking a certain station, you can stake a line at random stations using these 
buttons on the bottom right of the status bar:

Tap… to…

stake at fixed intervals starting at a certain station.

stake at random intervals somewhere along the line.

To toggle between Feature, Location, and Catch point staking, tap the icon in the bottom of 
the status bar on the right hand side of the main panel:

Icon Description

Feature

Location on Road Surface

Catch point
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Measuring with GPS
Setting up the GPS base station

Setting up the GPS rover receiver

Calibrating the site

Measuring a new control point with GNSS

To perform these measurement tasks, you need the Siteworks software running on a 
controller that is either connected to a positioning device like a GNSS system or a Total 
Station. This chapter explains how to set up and use the different components of an RTK 
GNSS system.

 

9
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Setting up the GPS base station
For Precision RTK (Real-Time Kinematic) GNSS operations, two main components are 
generally required, a base station and a rover receiver. The two components are 
connected by radio (450 MHz or 900 MHz frequency bands), Wi-Fi, or through several 
different types of Internet-based communication protocols over which RTK corrections 
are transmitted from the base station to the rover receiver. The base station is set up in a 
fixed location where it tracks the satellites of the GPS and, optionally, the GLONASS, Beidu, 
and QZSS constellations. The rover receiver moves around the jobsite on a pole, backpack, 
vehicle, or earthmoving machine.

The SPS Modular GPS (such as the SPS855) receivers have a front panel and keypad that 
enables the base station receiver to be initialized and set up without needing a controller; 
however, this guide focuses on using the Siteworks software to correctly set up the base 
station.

The base station setup process remembers how the previous setup was made. It 
automatically reconnects the components, selects the appropriate radio channel or 
network number used previously, and then automatically starts to transmit GPS positions. 
If the base station has never been previously established on the site, or if on the last base 
station setup a cellphone was used to broadcast corrections, you must completely set up 
the base station again using the options in the Connection Typeand Connection 
Methoddialog. In these situations, the Setup radio only option is not available.

When using the SPS Smart GNSS antenna or SPS Modular GNSS receivers, which use 
AutoBase™ technology, once a base station has been established for the first time, if 
nothing was changed between base setups, you can simply set up the receiver at the exact 
same base station location and then switch it on. Using AutoBase technology, the receiver 
reloads all appropriate data, makes all appropriate connections, and then starts to 
transmit corrections on the last used radio channel or network number. This eliminates 
the need to use a controller with the Siteworks software to set up the base station each 
day. If you want the SPS GNSS receivers (SPS Smart GNSS antennas, and the SPS Modular 
GNSS receivers) to operate in AutoBase mode, you must name each base station with a 
different name; otherwise the AutoBase mode will not work. The AutoBase technology can 
be configured in the web interface.  Note that you must set up the base station at the exact 
same antenna height each time for the AutoBase technology to correctly work (that is, the 
base station is set up on a dedicated rigid pole).  If different base antenna heights are used, 
for example on a tripod that is broken down and setup each day, then the base must be 
set up each time in Siteworks software using the following process to ensure the correct 
heights and settings are configured.
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To set up a GNSS base station:

 1. From the Home menu/ Project Setup, select connect device and then tap GPS.

 2. Set the Mode field to Base and then answer each question to complete the base 
station setup. In the Base position field there are several options on where the base is 
setup.

 l Control Point – An existing control point present on the site and imported into the 
Site folder.

 l Unknown Position – For a site with no known coordinates; uses an autonomous 
“HERE” position as the base location.

 l Local Coordinate – A site that has control points in local site coordinates.

 l Lat/Long/Height – Enables you to enter a known latitude/longitude and height, or 
use an autonomous “HERE” position.

 l Base Anywhere  – Allows the base to be set up anywhere on site, not on a control 
point, and will use an autonomous HERE position as its location.  Note this type of 
base setup should only be used with a rover receiver also configured in 
BaseAnywhere mode. For more information, see page 130.

You only need to set up the base station once; the software remembers your settings and 
prompts you to use the same ones the next time you set up the base station within a given 
site.  If necessary, you can then change any of the base settings such as the control point 
the base station is set up on or the antenna height. For new sites, the base will need to be 
set up from the beginning.
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BaseAnywhere base station setup
BaseAnywhere is a feature that enables a base station to be set up anywhere on the job 
site, including on the roof of a vehicle, a range pole with a bipod, or any other stable 
platform.  It does not require the base station to be set up on an established control point 
and greatly simplifies and quickens the ability to get started with an RTK GNSS survey on a 
site.  This feature is generally intended for use by smaller contractors on sites that do not 
have existing survey control points.

It works by setting the base station into AutoBase HERE Always mode, which means that 
each time the base station is turned on or power-cycled, the base will determine its 
autonomous position and begin to broadcast corrections on the last used radio or Wi-Fi 
settings. This base station setup configuration must be used with the associated 
BaseAnywhere and Bench My Rover configuration to ensure that correct positions are 
being used, as the “Here” position of the base station will change each time the base is 
restarted.

To configure the base receiver to broadcast in BaseAnywhere mode, select BaseAnywhere 
in the Base position field when setting up the base station: 

Once this mode for the base station is set there is no need to reconfigure the base station 
again unless there has been a 15-second restart of the receiver, you want to set up on a 
known point, or use/change any of the other base setup options.  Note that BaseAnywhere 
base stations can only be set up to broadcast corrections via the receiver’s internal radio 
or Wi-Fi.
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Also note that the base name when using BaseAnywhere will default to AUTO000X after a 
restart of the base receiver, where X is the number of times that the base has been started. 
So, if the base station has been restarted five times, the base station name will be 
AUTO0005. The base name broadcast from the base station will not match what was 
originally entered in the Base Setup screen.
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Setting up the GPS rover receiver
To set up the rover receiver:

 1. From the Home menu, select Project Setup / Connect Device and then tap GPS.

 2. Set the Mode option to Rover and then answer each question in turn to complete the 
rover setup.

You should only need to do this once per site; the software remembers your settings and 
will have them pre-filled for the next time you set up the same rover receiver in the same 
site.  You can change any of the rover settings if necessary. If any of the settings have 
changed, such as the base station radio channel, the rover will need to be configured from 
the start for each new site or to connect to a new base.

BaseAnywhere rover receiver setup
Using BaseAnywhere at the rover receiver involves benching the rover at a known control 
point so that a proper offset from the base station’s autonomous position to a known 
control point measured at the rover receiver can be determined.  After turning on and 
configuring a BaseAnywhere base station, and configuring the rover for use in 
BaseAnywhere mode, you are required to bench the rover receiver on a control point 
before any measurements can be taken.  The only exception is for new sites without 
existing control points that have not yet been calibrated. In this case, you are prompted to 
calibrate the site using a one-point calibration before any measurements can be taken.
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To use BaseAnywhere at the rover, select it from the Correction method field:

If your site does not contain any control points and has not been calibrated yet, you will be 
prompted to perform a one-point site calibration, which is the standard Siteworks 
workflow.  After performing the site calibration, you must measure at least one additional 
control point so that you can successfully perform a system check as part of the Bench My 
Rover process.

If the site is using an existing coordinate system or you are importing an existing calibration 
into a new site, you will need to have existing control points in the Site folder so that the 
Bench My Rover process can be completed.

To access Bench My Rover, tap the Home / Project Setup / Bench My Rover.  The icon is 
only available after a site has been calibrated.  When opening an existing calibrated site 
when using BaseAnywhere, you are taken to the Bench My Rover screen before being able 
to measure any points.

After entering the Bench My Rover workflow, the following screen appears prompting you 
for a Bench measurement point:
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Select the point by doing one of the following:

 l Tap it on-screen.

 l Tap  next to the Point Name field and select it from the list.

 l Tap  to enter a new control point.

After performing the Bench My Rover routine, you are required to measure a check point 
to ensure that the measurements are correct.  The software prompts guide you through 
the check point measurement process.  After measuring the check point, you will be shown 
the tolerances and given the option to select to measure a new check point or complete 
the Bench My Rover setup. At least one check point is required to be measured in order to 
use BaseAnywhere to ensure data integrity:
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After the Bench My Rover routine is performed, a prompt appears asking if you would like 
to update the position of the base location:

Selecting Yes will enable an update of the location of the base receiver from its 
autonomous position to its true RTK-calculated location.  This is now the equivalent of 
having a traditional base setup on a known control point.

Updating the base receiver location this way enables the base, while operating at its 
current location only, to be used for machine control applications and by additional rover 
receivers on site, without having to perform Bench My Rover routines on each rover.  If the 
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base receiver loses power, is restarted, or moved, a new Bench My Rover routine and 
updating of the base location must be performed before the base station can again be 
used by machine control applications or additional rovers.

Trimble recommends that you perform a Bench My Rover routine several times during the 
day, and any time after the base station may have moved (if for example, the base is placed 
on the roof of a vehicle). The software will force a Bench My Rover routine if it detects that 
the base station has been power cycled or if a new base name on the same channel is 
detected.

CAUTION – As with any base station setup, if the base station moves while 
transmitting corrections you will get incorrect measurements at the rover receiver. If 
base movement is suspected, performing a Bench My Rover will adjust for any 
movement in the base station.
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Calibrating the site
Global Navigation Satellite Systems (GNSS) produce positions in latitude, longitude, and 
height coordinates. Construction projects are generally designed in northing, easting, and 
elevation (or X,Y,Z) Cartesian coordinates. A project calibration ties the GNSS positions to 
the local site coordinate system so that GNSS can be used to measure or stake out on the 
construction site. The project calibration process involves measuring a number of known 
control points in the local site coordinate system using a GNSS rover, allowing the software 
to create pairs of measured latitude, longitude, height, and known control points.

To calibrate the project:

 1. From the Home menu, select Project Setup and then tap Project Calibration.

 2. If you have no control points in your project, you are prompted to enter a coordinate 
for where you are standing.  The software computes a one-point calibration based on 
this coordinate and will be oriented without any rotation so that the project’s local 
north direction will be true north:

 3. If control points exist in your project, you are prompted to select a control point and 
then measure the physical point on the ground with your rover receiver.  To add a 

calibration point in the Project Calibration table, tap the plus icon: 
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 4. When enough control points have been measured, horizontal and vertical residuals 
will appear on the screen.

 5. If these are acceptable, tap Finish to end the calibration.  The calibration is then used 
for the project.

The project calibration is stored in a DC file that can be used with other Trimble equipment 
working on the project. The software can also export the project calibration to a 
CompactFlash card as a CFG file for use with Trimble GS900 or Trimble Earthworks 
machine control systems. 

The software notifies you after three points have been measured whether the calibration 
is in or out of tolerance with respect to the calibration tolerances. After each point you 
have the following options:

 l measure additional points

 l retake a point flagged as potentially in error

 l save the partial calibration and resume later

The danger of using residuals as the only means of controlling a calibration is that the best 
precisions can be achieved using the wrong combination of points in the calibration 
solution. When an inclined plane is in use, this manipulation of residuals can result in a 
steeper tilt of the plane to best fit the data, resulting in better precisions and an in-
tolerance calibration. Monitor the tilt of the plane closely, especially when the geometry of 
the control points is not strong. Widespread control that covers the entire site is good; 
narrow-based control around a corridor is not as good. An incorrect tilt of the plane can 
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result in increasing errors in height as you move away from the center of the controlled 
area.

Once a project calibration is performed and completed, you cannot change or add to the 
calibration in that project. To add points to a completed project calibration, start a new 
project and import the existing DC file from the project which you want to add control 
points to.

You can review a project calibration completed in Siteworks by tapping the Home / Project 
Setup / Project Calibration. You are prompted if you would like to review the calibration 
report. Tap Yes to bring up a table showing the calculated scale factors, point pairs, and 
residuals:

Tap again in the table to activate the table and enable you to turn off/on individual points, 
to see the effects on the residuals and scale factors. Note however that this is a display-
only feature, therefore any changes made in the Project Calibration Review table are not 
saved, and the calibration will not be affected.

Performing a two-point calibration
Trimble recommends that wherever possible you use a multi-point calibration of at least 
three points. Use the two-point calibration method in situations where a baseline of only 
two control points is available. In the two-point calibration, the first point establishes the 
position and elevation for the project; the second point establishes the project orientation.
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In a two-point calibration, the heights for the project are computed using a simple block 
shift method that ties all heights to the first measured control point. A two-point calibration 
is carried out in the same way as a multi-point calibration.

Troubleshooting a site calibration
If a project calibration fails repeatedly, try the following solutions:

 l Try a different combination of control points. The software cannot always identify the 
bad point.

 l Start the calibration process again. You may have incorrectly measured a point or 
points.

 l Check the equipment. The source of the error may be as simple as the adjustment of 
the rod bubble, or a bent rod.

Once the system is set up there are limited sources of error when using RTK GNSS 
systems. The most common sources of error include:

 l A poor project calibration

 l Incorrect base antenna height

 l Incorrect rover antenna height

 l Incorrect selection of the correct antenna type at the base or rover, which causes 
height errors

 l Incorrect location of the base station antenna

 l A GPS rod bubble is out of adjustment or the rod is bent

These errors can easily be detected by rechecking the system setup. After starting the 
rover each day, the software prompts you to recheck the system setup. All recheck system 
setup operations are logged in the work order report and record files for reference and 
troubleshooting requirements.

NOTE – The prompt for a system recheck can be turned off by accessing the managers menu by 
tapping Ctrl+O (letter “oh”). Additionally, the prompt to adjust a published coordinate system with a 
site calibration can be turned off in this menu.

Trimble Siteworks Software User Guide | 141



Measuring with GPS

Measuring a new control point with GNSS
There are several reasons why you may need to measure a new control point during a 
project and then add the measured position to the Control Point file for the project. Typical 
cases include:

 l When operating the project with a mixture of GNSS and total station equipment; total 
stations require more control points around the project because of their line-of-sight 
dependence. Control points can be established very rapidly using GNSS and can be 
used later by total station crews to establish their position and orientation.

 l When operating a site, a base station often needs to be moved closer to the current 
working location to provide better radio coverage. The base station must be relocated 
to a known point in the local coordinate system, unless BaseAnywhere is used. Using 
the Measure control point option ensures that the point is created in the correct 
location, with the correct coordinates, and guarantees that the project calibration 
remains valid after the base station is moved.

 l When carrying out topographic measurements on a new site before control for the 
project is established, you may set the base station up in an arbitrary and convenient 
location and then carry out a single-point calibration. Once completed, measuring 
three or more control points around the project provides a common set of reference 
points that can be used later to transform the data measured using the single-point 
calibration, to the project coordinate system once it is established.

 1. From the Home menu, tap Measure / Measure Control Point.

 2. Create the control point location using a stake, a hub, or a road nail as required and 
then mark the stake with the name for the control point, for example, CP3.

 3. Set up the GNSS rod over the point and hold it steady using a bipod. The software 
displays the current GNSS position on the map.

 4. When you are ready to take the measurement, tap the Measure icon. The 
measurement process takes approximately 15 seconds to complete. Measuring for 15 
seconds takes an average position that increases the accuracy of the computed 
control point.

When each control point is measured, the software stores the control point data position 
in the control point (Control.field.csv) file for the site, and also records the measurement 
data into the record and report files for the work order.
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Measuring using xFill technology
The optional xFill™ option for SPS GNSS receivers allows maintaining an accurate 
positioning solution for an additional four minutes after the main correction data source 
has been dropped, for example, in a radio blackspot or in an area where no cell coverage is 
available when measuring with VRS™ technology.  During this time the receiver uses L-band 
satellite-based corrections. If the correction data source is restored during these four 
minutes, the xFill technology seamlessly drops in and out. Points measured with xFill 
technology are stamped as such as the accuracy decreases when coming closer to the 
four-minute mark. 

To use the xFill technology, the receiver needs to track the xFill satellite for at least 15 
minutes.

Static measurements
If the receiver has the Data Logging option installed, the software can configure an SPS 
GNSS rover receiver for static measurements.

Static measurements allow for the averaging of the GNSS results over a user-selected time 
period, resulting in a more precise position.

To set up the receiver for static measurements:

 1. From the Home menu, tap Project Setup and then tap Connect. The following dialog 
appears: 
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 2. Set the Mode option to Rover and then answer each question that appears to 
complete the rover setup.

 3. After setting up the receiver a message may appear asking if you want to calibrate the 
site; tap No.

 4. Change the measurement mode to Static; tap the Measure mode  icon in the 
status bar on the right hand side of the main panel and then tap the static icon:

Alternatively, select the Home menu / Settings / Measure Mode. Selecting Static opens 
the following dialog:
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 5. Complete the options for the antenna height, how long you want to measure for, and 
select whether or not to store the raw data in the receiver. You need to measure at 
least four minutes to store RAW data in the receiver, which can then be used for 
postprocessing.

If you wish to log the file into the receiver for later download via USB cable or the web 
interface, enter a point name into this field that will be saved into the .T02 file. This log 
point name will appear as the point name when the .TO2 file is imported into the 
Trimble Business Center software.  Note that the point name entered in the Static 
Mode Settings screen is different than the point name that is entered after the static 
measurement is complete.  The name entered first into the Static Mode Settings screen 
is only stored in the .T02 file.  The name prompted for after the measurement is 
complete is the point name stored and displayed in the work order in the Siteworks 
software.

 6. When you are ready to start the Static measurement, tap the Measure icon and check 
the Static Mode Settings. Then tap Start. The software counts down the time that you 
have entered and then gives you the option to fill in the point name and code and 
accept and store the measurement.

NOTE – If the receiver loses power, is shut down, or the measurement canceled, no TO2 file 
containing the raw data will be saved, and all the static data for that point will be lost.
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Siteworks software supports eBubble functionality for GNSS receivers that contain the 
appropriate tilt sensor hardware (currently the Trimble SPS986 and R10 receivers).

10
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eBubble operation
The eBubble is displayed in the top or bottom side panel. It is turned on by tapping on the 

down arrow and selecting eBubble. .  

The eBubble is automatically available whenever a compatible receiver is connected to the 
Siteworks software.  It shows the degrees of tilt in the lower left, and the tilt distance in site 
units (meters, international feet, US survey feet) in the lower right, calculated based on the 
current rod height. The bubble turns red when the tilt distance exceeds the tilt tolerance 
value input in the eBubble Settings screen. The  eBubble can only be displayed in the side 
panels and not the main working panel.
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The eBubble can also be turned on or off by going to the map display options (select the 

settings Icon ) and choosing eBubble under the Panel Display tab of the Map 
Options screen.  Select the check box to display the eBubble.

To access the eBubble settings, from the   main menu, select Settings / eBubble.
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eBubble calibration
The first time a SPS986 smart antenna is used, and every 30 days afterward, it needs to 
have its tilt sensors calibrated to use the eBubble.  To perform a calibration, ensure that the 
receiver is level and plumb using a calibrated reference (for example on a tripod and 
calibrated and leveled tribrach) and tap the Calibrate Tilt Sensor button to begin the 
calibration.  The receiver must have a clear view of the sky and a satellite lock while 
performing the calibration, as GNSS time is used to timestamp the calibration.  A minimum 
of four  satellites is necessary to be tracked during the calibration.  If the receiver is moved 
significantly during calibration, the process will restart until it is completed without any 
motion or you cancel it.
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After the calibration is complete, a message appears indicating the finished calibration.  The 
receiver’s front panel must be facing you for correct operation, as the eBubble’s 
movements and display within Siteworks are oriented based on the receiver’s front panel 
facing the operator.  When mounting and using the receiver in vehicle mode, the front 
panel should be oriented towards the rear of the vehicle .
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CAUTION – A well-calibrated eBubble is of vital importance. The accuracy of tilt 
information used to display the eBubble, and stored with measured points, is totally 
dependent on the calibration of the tilt sensors inside the GNSS receiver.  Using a 
poorly-calibrated eBubble directly degrades the accuracy of the coordinates measured 
using the eBubble as a level reference. Great care should be taken when you are 

calibrating the eBubble to ensure the most accurate tilt information is available at all 

times.

 l Bubble reference: Calibrate the eBubble against a properly calibrated physical 
bubble. The accuracy of the eBubble depends totally on the accuracy of the physical 
bubble used to calibrate it.

 l Pole stability: When calibrating the eBubble, the pole the GNSS receiver is on 
should be as vertical and as stable as possible. In practice this means using at least 
a bipod to hold the pole as still as possible.

 l Pole straightness: A bent pole affects the tilt measured by the sensors in the GNSS 
receiver. If you calibrate the eBubble using a bent pole and then change poles, the 
accuracy of points are affected. Likewise, if you calibrate using a straight pole and 
then change to a bent pole, the GNSS will not be plumb even though the eBubble 
will say it is, again affecting the accuracy of the measured points.

 l Abuse:  If the GNSS receiver suffers severe abuse such as a pole drop, you should 
recalibrate the eBubble.
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eBubble settings
The eBubble Settings screen contains controls for the eBubble response, eBubble 
sensitivity, tilt tolerance, tilt warning, and performing an eBubble calibration:

The eBubble response setting controls how quickly the bubble’s position is updated on 
the screen, which affects its speed of movement. 

The eBubble sensitivity setting controls how much the bubble moves on screen for a 
given change in angle.  Select High to make the eBubble move a lot for a given change in 
angle, and Low to move the eBubble a little for a given change in angle.  Changing this 
sensitivity value also affects the diameter of the Tilt Tolerance display of the inner ring of 
the eBubble display.  The inner ring of the eBubble display represents the tilt value where 
the calculated tilt distance will exceed the Tilt Tolerance amount.  The eBubble will turn red 
when the bubble touches or extends beyond this inner ring.  The diameter of the inner ring 
changes depending on the current rod height, eBubble sensitivity setting, and the Tilt 
Tolerance value.

The Tilt tolerance setting is the value at which the eBubble display will turn red, and a 
warning will appear if a measurement is taken while the tilt distance is greater than the Tilt 
tolerance value.  Select the Enable tilt warning for measurements check box to activate a 
warning message if a measurement is made and the tilt distance is greater than the Tilt 
Tolerance value.
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Tilt data are stored with each point measured with a compatible receiver and can be 
viewed by tapping-and-holding on a point and selecting Point Information, or by viewing 
point information via the Point Manager.  The Tilt Angle, Tilt Error, and Tilt Tolerance values 
are stored.  These tilt values are included in exported CSV data if the Include QA data 
option is selected.
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Measuring with a Total Station
Connecting to a total station

Leveling the total station

Establishing the station

Arbitrary location

Setting up on a known point

Reading station setup data from the total station

Using the last station setup

Completing a station establishment setup where the height of the setup point has not 
been determined

Measuring a new control point or remeasuring a control point with a total station

Outputting data through the COM port

Computing the total station scale factor

To perform measurement or stakeout tasks, you need the Siteworks site controller 
software running on a controller that is connected to a positioning device. This chapter 
explains how to set up and use SPS Series total stations with the Siteworks software.

 

11

Trimble Siteworks Software User Guide | 154



Measuring with a Total Station

Connecting to a total station
When you start the software the most common connection to the total station is through 
a radio. The connection can also be made through Bluetooth or a cable although both 
these methods require you to be in close proximity to the total station. When the 
connection is made, the Level Compensator screen (see Leveling the total station, page 
157) appears.

The connect to total station screen either automatically appears during the project startup 
process or can be accessed via  Home menu / Project Setup / Connect Deviceand selecting 
total station. This opens the Connect to Total station menu where you can select the 
connection type. 

If you are setting up a radio connection for the first time:

 1. Select Trimble as a Brand.

 2. Select the model of total station you are using. The most common is the SPS series. 

 3. Select Radio as the connection type.

 4. Ensure the total station is turned on and configured for a radio connection. The screen 
of the total station should say waiting for connection. 

 5. Select the Radio channel and Network ID that are displayed on the total station screen.

 6. Tap ACCEPT and follow the instructions that appear on the screen.
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If you are using Bluetooth wireless technology to connect to the total station:

 1. Select Trimble as a Brand.

 2. Select the model of total station you are using. The most common is the SPS series. 

 3. Select Bluetooth as the connection type.

 4. Ensure the total station is on and  the Bluetooth is turned on in the total station. The 
screen of the total station should say waiting for connection.

 5. Enter the PIN code set in the total station.

 6. Tap ACCEPT and follow the instructions that appear on the screen.

If you leave the controller in GPS mode, it cannot find the connection even if it is connected 
directly to a total station.

To connect to the instrument via cable:

 1. Select Trimble as a Brand.

 2. Select the model of total station you are using. The most common is the SPS series. 

 3. Select Cable as the connection type.

 4. Tap ACCEPT and follow the instructions that appear on the screen.

Disconnecting from a total station
After successfully connecting to the total station, a disconnect button appears in the Home 
menu/ Project Setup. Tapping this button disconnects the controller from the total station 
and places the total station into standby mode, where it can be picked up by a GCS900 or 
Earthworks machine control system, or re-connected to in Siteworks.  This feature is 
beneficial if you are using machine control systems, as you no longer need to travel back to 
the instrument to physically power cycle the instrument or unplug the battery to put the 
instrument into standby mode so a GCS900 or Earthworks system can connect.
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Leveling the total station
The compensator inside the total station provides dual-axis correction for any misleveling 
of the instrument during operation, for a working range of up to 6' of arc. The display 
enables you to level the total station accurately using the foot-screws on the tribrach. Note 
if the total station is too far off level, no level data will appear in this screen. To remedy this, 
get the bubble on the total station tribrach approximately level

To level the total station:

 1. Align the front face of the total station with two tribrach foot-screws.

 2. Adjust the horizontal bubble in the display using those same two foot screws.

 3. Adjust the vertical bubble using the third foot screw.

 4. Once level, tap ACCEPT.

You can disable the compensator, however, only do this in extreme working conditions 
such as when working:

 l in close proximity to a piling rig, vibratory compactor, or other source of extreme 
ground vibration that would continuously affect the compensation effect on the total 
station.

 l on a mobile platform where the level is continuously changing, but where all 
measurements are needed in the reference frame of the platform itself, for example on 
a marine vessel or oil platform.
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 l in extremely windy conditions where wind buffet on the total station is significant, and 
would continuously affect the compensation of the total station.

If the compensator is switched off, the total station stops correcting for instrument 
mislevel. In these situations, watch and adjust the level on a regular basis. At this point, 
Trimble assumes that the total station is set up accurately over a known point (see Setting 
up on a known point, page 165) or that you have set it up in a convenient location, and will 
establish its position via a resection using the Arbitrary location (see Arbitrary location, 
page 159).

Establishing the station
You must know the total station position and orientation if the total station is to be used 
for site measurement or stakeout operations where the positions computed are related to 
a project coordinate system. There are two methods of establishing the position and 
orientation of the total station:

 l Arbitrary location  (see Arbitrary location, page 159, also known as free station or resection)

 l Setting up on a known point (see Setting up on a known point, page 165)

Once the station setup has been established, the total station can be used for 
measurement or stakeout operations. 

If you have not yet established the position of the total station and you select a 
measurement or stakeout function, the software automatically forces you into the 
instrument setup process when connected to a total station. If you have not entered any 
control point data for the site, the station establishment process only allows you to set up 
at a manually entered coordinate location and orientation of the angle system to 0.000 in a 
chosen direction. This method is acceptable only if you are measuring a new site that has 
not been measured before and provided that you are not trying to measure or stake 
anything from a loaded design. In most cases, you should have control points available.

You can take angle-only measurements during a station setup, both when the total station 
is set up on an arbitrary location or on a known control point.  Using the angle-only option 
will not calculate any distance errors in the setup table.  When performing an angle-only 
setup on an arbitrary location, you must shoot a minimum of three control points.  Only 
two control points are necessary when a distance measurement is taken.
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Arbitrary location
The arbitrary location setup enables you to set up the total station at a location that is 
convenient for the operation to be carried out (and not over a known point). It measures 
the angle and distance to two or more known points to determine the position and 
orientation of the total station.

 1. In the Home menu, select Project Setup / Total Station Setup. If you just connected to 
the total station, the software prompts you for the station establishment method. 
Select the Set up at an arbitrary location option:

 2. Add at least two control points:
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 3. Select a point on the map by tapping directly on it and entering the name into the text 

box, or from the list, by tapping  on the upper right side and then tap ACCEPT:

 4. Configure your measurement settings by selecting the measurement mode (Standing, 
Averaging, DR, DR Target, or DR Averaging), prism target type and height (in Standing 
and Averaging modes), DR options (in DR, DR Target, or DR Averaging modes), 
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measurement sets and tolerances (in Averaging and DR Averaging modes), and 
whether Angle only and/or Autolock (for prism targets) measurements should be used:

 5. After the measurements are complete, the Station Setup table will indicate if the setup 
is in or out of tolerance:

 6. Tap Settings to adjust the setup tolerances for horizontal and vertical distances and 
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angle tolerance:

 7. Tapping Report gives more detailed information about the setup quality of the station:

 8. To change the instrument elevation by shooting in a benchmark point, select the 
Overwrite instrument elevation with benchmark measurement check box.  At the end 
of the measurement process, you will be prompted to shoot a benchmark point from 
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which the station elevation will be calculated:

NOTE – The station elevation is calculated relative to this benchmark elevation; it does not 
simply set the instrument elevation to the benchmark elevation.

 9. Tap ACCEPT to complete the arbitrary instrument location setup and view the 
coordinates of the instrument setup.

A prompt will appear asking if you would like to save the instrument location as a 
control point.  Tap YES to store the instrument location as a control point, and NO to 
ignore it:
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If you tap YES, you are prompted to enter a point name and an instrument height:

The instrument height can be measured in two ways: 

 l a vertical height from the ground surface to the center crosshair mark on the side 
of the instrument
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 l the slope height, measured directly from the control point to the bottom notch on 
the side of the instrument.  

Selecting the slope height is generally easier to perform more accurately in the field, 
due to potential height variations between the control point hub and the surrounding 

ground surface and the ability to get a tape measure to the notch. Tapping the  on 
the Instrument height field opens the following screen, where you can select the 
measurement method:

NOTE – If a slope height is entered, the vertical height is automatically calculated by adding 
.156 m or .511 feet to the slope height. The updated vertical height will be displayed as the 
instrument height in the Save Instrument Point window.

Setting up on a known point
This enables you to set up the total station over a known control point and then measure 
to one or more reference backsight control points to establish its position and orientation 
on the jobsite. In most cases, a single reference backsight control point may be all that is 
required. In other cases, where the accuracy of the work is higher, measuring more than 
one reference backsight control point can provide better control over the orientation of 
the total station and a further check that the control point at the total station position or 
any of the measured reference control point locations has not moved.  You can follow 
similar steps to those used in the arbitrary location method of station establishment. 
Select from one of the following options:

Trimble Siteworks Software User Guide | 165



Measuring with a Total Station

 1. From the Home menu, select Project Setup / Connect Device and tap . If you have 
just connected to the total station, the software prompts you to select the station 
establishment method. Select the Set up on a known control point option and then 
click ACCEPT.

 2. Select the instrument’s location point by tapping directly on it and entering the name 

into the text box, or from the list, by tapping  in the upper right side and then 
tapping ACCEPT:
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 3. Enter the instrument height:

The instrument height can be measured in two ways: 

 l a vertical height from the ground surface to the center crosshair mark on the side 
of the instrument
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 l the slope height, measured directly from the control point to the bottom notch on 
the side of the instrument.  

Selecting the slope height is generally easier to perform more accurately in the field, 
due to potential height variations between the control point hub and the surrounding 
ground surface. 

NOTE – If a slope height is entered, the vertical height is automatically calculated by adding 
.156 m or .511 feet to the slope height and the updated vertical height will be displayed as the 
instrument height in the Save Instrument Point window.

 4. Add at least one control point to backsight to by tapping ADD POINT. 

 5. Select a point on the map by tapping directly on it and entering the name into the text 

box, or from the list, by tapping  in the upper right side and then tapping SELECT:
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 6. Configure your measurement settings by selecting the measurement mode (Standing, 
Averaging, DR, DR Target, or DR Averaging), prism target type and height (in Standing 
and Averaging modes), DR options (in DR, DR Target, or DR Averaging modes), 
measurement sets and tolerances (in Averaging and DR Averaging modes), and 
whether Angle only and/or Autolock (for prism targets) measurements should be used:

After the measurements are complete, the Station Setup table indicates if the setup is 
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in or out of tolerance:

 7. Tap Settings to adjust the setup tolerances for horizontal and vertical distances and 
angle tolerance:

 8. Tap Report to get more detailed information about the setup quality of the station:
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 9. To change the instrument elevation by shooting in a benchmark point, select the 
Overwrite instrument elevation with benchmark measurement check box.  At the end 
of the measurement process, you will be prompted to shoot a benchmark point from 
which the station elevation will be calculated:

NOTE – The station elevation is calculated relative to this benchmark elevation; it does not 
simply set the instrument elevation to the benchmark elevation.
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Reading station setup data from the total station
After you have performed a station establishment, the total station stores the information 
in its memory, so that other controllers running the software can access it. Subsequent 
Siteworks software users can save time by simply retrieving the station setup information 
from the total station’s memory without resetting up at an arbitrary location or on a known 
control point.

Note that only one controller is able to connect to a total station at the same time. To 
retrieve this setup information, connect to the instrument and select Read station setup 
data from instrument in the Total Station Setup screen:

Using the last station setup
If the total station has not moved since being setup last, you can connect to the instrument 
and select Use last setup. This uses the same station setup parameters from the last time 
the instrument was setup. This method is useful for performing setups after the total 
station has been powered down or the battery replaced, but the instrument has not 
moved off the tripod.
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Completing a station establishment setup where the 
height of the setup point has not been determined
If the height of the total station has not been established at the end of the station 
establishment process, the software prompts you to either enter a known height for the 
setup point or to a height from a known benchmark location defined as a 1D or 3D point. 
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This occurs when:

 l setting up at an arbitrary location and the reference backsight control points 
measured were all 2D control points.

 l setting up on a known point and the known point and reference backsight control 
points selected were all defined as 2D control points.

The benchmark point is measured in the same way as any other control point. It is used in 
combination with the target height and instrument height to determine the setup point 
elevation.

Measuring a new control point or remeasuring a 
control point with a total station
Total stations require more control points around the project because of their line-of-sight 
dependence; therefore it may be necessary to set and measure additional control points 
throughout the site.

NOTE – The measure mode (Standing, Averaging, DR, DR Target, DR Averaging) selected prior to 
entering the Measure Control Point command is the mode that will be used to measure the control 
point.  Ensure the proper mode is selected prior to entering the command.  For the highest 
accuracies, it is recommended to use Averaging mode when using a prism on a bipod, or a 
backsight prism on a tripod.  If the control point is to be measured refelectorlessly, DR Averaging is 
the recommended mode.
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 1. From the Home menu, tap Measure / Measure Control Point.

 2. Select New Control Points from the menu to measure a new control point, or Existing 
Control Points to remeasure existing control points to check their position.

 3. Create the control point location using a stake, a hub, or a road nail as required on the 
ground and then mark the stake with the name for the control point, for example, CP3.

 4. Set up the Prism rod on the point and hold it steady using a bipod. The software 
displays the current Prism position on the map.

 5. When you are ready to take the measurement, tap the Measure icon.

When each control point is measured, the software stores the control point data position 
in the control point (Control.field.csv) file for the site, and also records the measurement 
data into the record and report files for the work order.

Outputting data through the COM port
In some applications, it is useful to have the controller deliver the raw measurement data 
or the computed coordinate data to the serial port of the controller, so that other 
software, for example hydrographic positioning applications, can pick it up and use it.

To set up the COM port:

 1. Connect to the SPS total station and complete a station establishment. 

 2. From the Home menu, tap Settings and then tap Total Station Settings. The Total 
Stations Settings dialog appears.
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 3. Tap the Settings tab: 

 4. Enable the Raw data output option.

 5. In the Output format list, select either HAVASD raw data or XYZ coordinates.

RAW data format Coordinate data format

0 0

7 = HA 37 = Northing

8 = VA 38 = Easting

0 = SD 39 = Elevation

The first line of data is always a 0, which is a status tag indicating a complete 
measurement record.

Each line of data is terminated with a carriage return and line feed.

NOTE – Coordinate Data output is always in meters, regardless of the units selected in the 
Site.

 6. In the Output mode list, select either the After recording (every time you tap Record) 
option or the Continuous (every time the total station has a new measurement) option.

 7. In the COM Port list, select the controller port through which to send the data.

 8. In the Baud rate list, select the rate in bits per second that you want to send the data to 

Trimble Siteworks Software User Guide | 176



Measuring with a Total Station

the COM port.

NOTE – Parity is set to 0 (No Parity), data bits is set to 8, and stop bits is set to 1. You cannot 
change these settings.

 9. Tap OK. Once the connection is established, and measurement commences, the data 
will be sent to the selected COM port in the format you selected.
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Computing the total station scale factor
The software can calculate a projection scale factor using a preselected coordinate system 
or site calibration in the site folder, for example, to measure accurately in a zone of the 
UTM coordinate system. 

To enable the automatic project scale factor:

 1. From the Home menu, tap Settings. 

 2. Tap Total Station Settings. The Total Stations Settings dialog appears.

 3. Tap the Corrections tab: 

 4. You can enter a fixed scale factor, leave the scale factor at 1, or let the software 
calculate a scale factor based on the site calibration measured with GNSS or imported 
from Business Center. The software uses the instrument coordinates resulting out of 
the station establishment to calculate the correct scale factor for this instrument 
location in the selected coordinate system zone.

Enabling the Mean sea level correction check box will account for the elevation of the 
instrument above mean sea level and incorporate an appropriate scale factor. This 
check box should be selected after at least one GNSS point is measured or a site 
calibration has been performed, as the GNSS elevation data from the site calibration is 
used to set the project elevation in the mean sea level correction calculation.

Once the option is set to Computed and site measurements have been taken, the 
Computed option is locked to guarantee the consistency of the measurements.
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The automatic scale factor is also written to the instrument scratch pad to apply it for 
machine control operations with the GCS900, Earthworks, or AccuGrade grade control 
systems.
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Setting up for machine control
From the Home menu, tap Project Setup / Machine Control Setup 

.

If the instrument has the OEM option installed, an OEM Mode is available. To set up the 
instrument for a Trimble GCS900 or Earthworks machine control system, select Machine 
Control Mode.

Defining the window for Full Search mode
When defining the window for the Full Search mode:

 l Accommodate the fact that the prism can be mounted on an electric mast, and that 
the vertical window of operation at close range will be higher or lower than at longer 
ranges.

 l Ensure that you set the window of operation to cover the extents of all grading 
operations to be completed from that location's instrument setup.

 l Ensure that if the machine is taken outside that window, to turn around or to bench on 
a known height point, those locations are also included in the search window.

You can define either the upper left/lower right extents of your search window or the 
upper right/lower left extents of your search window. Ensure that you take a good look at 
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any high or low points in the area where you will be working and then define your search 
window to what most closely resembles the actual working area in front of the instrument.

 l Point the total station to an upper left location and then to a lower right location; tap 
the appropriate Set button at each pointing.

 l Point the total station to an upper right location and then to a lower left location, 
tapping the appropriate Set button at each pointing.

You can use the joystick function, or physically turn the total station by hand to aim at the 
corner points.  To use the joystick to set the corner points, tap JOYSTICK and use the 
joystick commands to point the total station to one corner. When the total station is 
pointed in the correct location, tap ACCEPT in the Joystick window to return to the Define 
Search Window, and then hit the appropriate corner’s Set button. Repeat this process for 
the opposite corner.

As soon as the first corner is defined, the only option available in the software is to define 
the opposite corner. For example, if you define the upper right extent first, the lower left 
corner only is made available to define. If the lower right corner is set first, then the upper 
left corner only is made available to define.

A single SPSx30 total station can be shared by multiple machines and a single SPS robotic 
rover pole. Only one user can use the total station at a time, but when not in use, it 
continually scans a predefined list of radio channels assigned to different machines and 
the last used site positioning system channel in sequence, looking to see if anyone needs 
access to the total station. When a machine or site positioning system calls the total 
station, it connects and provides a positioning service. When completed, the total station 
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returns to Standby mode and becomes available to the radio channels previously loaded 
to the instrument. Note that this process is made easier in Siteworks software by tapping 
the Disconnect button in the Project Setup menu after the Siteworks uses are complete. 
To facilitate this process, in the set up for machine control process, you can create a list of 
machines, each with a name and a specified radio channel, for example:

 l CAT 140H Grader 1 33

 l CAT D6 Dozer 1 34

The machine list is scanned sequentially whenever the total station is placed in Standby 
mode for machine control. The more entries in the list, the longer the scan takes to 
complete a full cycle and therefore the slower the initial connection will be with the total 
station. If you are not continually using the entries in the list in earthmoving operations, 
delete the entries from the list to speed up initial connection times.

Tap the + icon to create a machine in the machine list, enter a machine name and assign a 
network channel. Also, select a Network ID for the instrument.

This completes the instrument setup. The total station goes into Standby mode waiting for 
a machine to connect to it. Tap NEXT to confirm the machine control setup:
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If you are tracking a machine and the target becomes lost for any reason, the total station 
continues to turn at a constant horizontal and vertical speed for a short period, in the 
expectation that the target will appear on the same trajectory when it clears the 
obstruction. A line-of-sight obstruction, a passing vehicle, or simply losing the target 
because of movement speed can cause the total station to lose the target. When the target 
is 'lost', that is, the above method failed to reacquire the target, the total station searches 
for the target. The total station has two search modes:

Mode Description

Quick Search Initiated as soon as the target is 'lost'. This search is centered on the 
last known location, and inside a window defined by a horizontal angle 
width (for example, 15°) and a vertical angle width (for example, 15°). 
The machine control software sets the values for the search window.

Full Search This search looks inside a larger window, defined by the dialog shown 
previously. When the Quick Search mode fails to locate the target, the 
Full Search mode is initiated.

If you are operating at the total station, point it at the MT900 target on the machine. When 
the machine connects to the total station, this speeds up the initial search and lock-on 
process for the total station as it instantly “sees” the target and locks to it. The total station 
goes into Standby mode for machine control and then it scans the machine list in 
chronological order until a machine is found calling the instrument on one of the channels. 
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The software now disconnects from the total station. Move to the machine and initiate 
connection to the total station.
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Advanced Total Station 
Features

Scanning stockpiles

Adjusting the total station

Measure Control Network

Measuring rounds of angles

Direct reflex (DR) technology is included in all SPSx30 Universal Total Stations as well as all 
SPSx20 Construction Total Stations. This technology offers many advantages such as 
stockpile scanning for accurate volume calculations.

The range varies depending on the total station you are using:

 l The SPS620 and SPS720 total stations offer DR Standard technology, which enables 
you to measure reflectorlessly, to a maximum distance of 150 m (492 feet).

 l SPSx30 total stations offer DR+ technology, allowing reflectorlessly measurement of 
objects up to 1,600 meters (5,249 feet) from the instrument.

13
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Scanning stockpiles
The Stockpile scan is designed to collect very accurate data for reporting on the volume of 
material that you have or that has been excavated. By scanning the stockpile or excavation, 
the need to place a worker in potentially unsafe conditions is eliminated. Reflectorless 
measurement technology enables you to set up the total station and measure to surfaces 
without using a target or prism.

Given the line-of-sight restrictions when using a total station, you need to perform a 
minimum of two station setups to collect all sides of the stockpile:

 1. From your first setup, measure new control points around the stockpile in locations 
that will give you the fewest setups and the best vantage points to scan the largest 
surface area of the stockpile. This enables you to collect all sides of the stockpile and 
have the surface points correctly related to each other. 

 2. Once the whole stockpile has been scanned, define a volume boundary in the Cogo 
menu by tapping the points to be used to define the boundary, and then perform a 
volume calculation in the field.

To set up stockpile scanning:

 1. From the Home menu, tap Measure and then tap Stockpile Scanning.

 2. The software sets the instrument to DR mode, and then the following screen appears:
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 3. Define the shape of your stockpile. Start by tapping the gray dot at the highest point of 
the stockpile image on the screen.

 4. Manually sight your instrument to the highest point of the stockpile and then tap 
Measure. The Point Mode dialog appears.

 5. If required, enter a point code and point name and then tap OK. The Stockpile 
Scanning Setup dialog reappears.

 6. Repeat Step 4 through Step 6 to define the bottom left, bottom right, and bottom most 
points of your stockpile. Once successfully measured, the points appear green:

NOTE – This feature and the way that the corner points are configured in Siteworks software is 
based upon setting the target points on a vertical plane.  The lower left and right points set the 
vertical edges of the plane, and the top and center bottom points define the upper and lower 
horizontal edges of the plane.  If this feature is used at long range, along a gently sloping surface, 
and/or with a large vertical distance between top and bottom points, it will result in a non-
uniform “fan-shaped” spacing of points, as the scan continues to measure points located 
upwards along the plane, and further from the instrument.  This feature is not a substitute for 
traditional 3D laser scanning methods.

 7. Tap Next. The Stockpile Scanning Settings dialog appears:
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 8. Enter a point name and code and set the horizontal and vertical distance intervals. 
Setting the distance intervals low results in more measured points; setting the distance 
intervals high results in fewer measured points. Also, having a smaller interval (more 
points) will result in a longer scan. When entering these values, keep the size and shape 
of the stockpile in mind. Define your minimum and maximum distances for point data 
collection and then tap Next. Correct use of these settings helps you collect only the 
relevant points in the field on your stockpile.  If a point falls outside of these distance 
values, it will not be measured.  Consider setting the minimum distance to be 
approximately the distance from the instrument to the bottom of the stock pile (closest 
desired point to be measured), and the maximum distance to be near the top of the 
stockpile (furthest desired point to be measured). The software will default to the 
recommended Timeout value depending on which instrument is being used.

 9. The Scanning Area Estimates dialog displays the total number of points to be collected 
as a result of the dimension and distance intervals previously entered and an 
estimation of the time it will take to record the points. This time is an estimate only and 
the reflectivity of the material, distances involved, and the type of instrument used 
alters the total time once the scan has started.
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CAUTION – The values stored in Step 8 are overwritten by the minimum and 
maximum values set in the DR Target Settings dialog. Ensure that you check the 
values set in the DR Target Settings dialog to eliminate confusion by another 
operator when they are setting the Stockpile Scan settings. Setting the minimum 
distance to 2 meters (6.56 feet) and maximum distance to 1600 meters (5,249 feet) in 
the DR Target Settings dialog will eliminate any errors when setting the Stockpile 
Scan settings.

TIP – When working at the maximum ranges of the DR technology, increase the 
Timeout Setting. When adjusting the timeout settings, be aware the material being 
measured affects the strength of the response signal. Also, the instrument's 
technology affects the time it takes to record each individual point.

 10. Either tap the back arrow to go back and change any settings before starting the scan 
or tap Start to start the scan.

 11. A grid is displayed as the scan proceeds. Scan time remaining is displayed in the 
Estimated Time Remaining field. If you need to change the minimum and maximum 

distance settings, tap Pause and then tap . Change the minimum and maximum 
settings and then tap Next. The scan will resume.

 12. Tap  in the map control bar on the right to display the map view so you can see the 
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points being collected.

TIP – For an explanation of the different grid sector colors, tap  in the upper right 
of the screen. The following screen appears:

 13. To rescan any cells, tap OK to return to the measured cells display. Tap the associated 
grid sectors with your stylus. Selected sectors turn blue. Once the selection is made, 
tap Rescan. Repeat the rescan function until results are satisfactory and then tap 
Finish.
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Adjusting the total station
All total stations require regular and routine checks and adjustments to deliver optimum 
results. All Trimble total stations allow fully accurate measurements to be made with a 
single pointing to a target. To achieve those results, the total station stores its current 
adjustment values internally, and then corrects all measured data accordingly. For 
accurate measurements to be made, the current adjustment values need to be 
determined and stored in the memory. Total station adjustments are required because of 
the optical-mechanical design of the instrument. The following conditions can move the 
optics and mechanics out of adjustment:

 l Shipping and handling

 l Bumps and knocks

 l Temperature and pressure changes

 l Storage conditions

 l General wear and tear of mechanics

To start the calibration:

 1. From the Home menu, tap Settings / Total Station Calibration.

Compensator Calibration

CAUTION – You must perform this calibration before the HA VA Collimation and 
Tracker Collimation. The compensator does not need to be calibrated every time 
the other collimations are performed, but if the Compensator Calibration is 
performed, you should immediately perform the HA VA Collimation and Tracker 
Collimation. Performing the Compensator Calibration negates the validity of the 
values of the errors found from previous HA VA Collimations and Tracker 
Collimations.

The SPS family of motorized total stations is all equipped with a dual-axis compensator. 
The compensator is active when the total station is switched on. You should 
periodically calibrate the compensator to adjust for any minor changes in the total 
station caused by normal wear and tear, as well as shipping or temperature variations. 
It is extremely important to perform this calibration when you are working within a very 
tight tolerance range. You should also perform this calibration whenever the highest 
accuracies are needed.

 2. Tap Start to initiate the instrument Level Compensator Calibration:
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 3. Tap OK.

HA VA Collimation test

You should perform this test to a target that can be easily bisected with both the 
horizontal and vertical cross-hair, placed at a location at least 100 m (328 feet) from the 
total station, and at approximately the same elevation as the total station telescope. 
The target can be any object including a road sign, window frame, or an adhesive prism 
target. The test involves taking a series of HA VA measurements to the target in both 
instrument faces, to generate a mean or averaged pointing in face 1 and face 2, from 
which the difference between face 1 and face 2 readings can be determined. The 
difference between the two face readings is known as the collimation error. In the 
horizontal axis, the collimation error has little effect on measurements. However in the 
vertical axis, if not corrected for, the collimation error will result in erroneous elevation 
values for all measured points.

 4. Enter the number of measurements, aim at the target and then tap Measure:

Trimble Siteworks Software User Guide | 193



Advanced Total Station Features

The collimation test computes the collimation error, stores the error inside the total 
station and then corrects all subsequent measurements for that error before 
displaying them on the screen or storing them in memory.

 5. Tap Next.

Tracker Collimation test

You should perform this test towards a prism or active target set up at a distance of 
around 100 m and at approximately the same elevation as the total station telescope. 
Ideally, perform the test at the approximate range that subsequent measurements will 
be made.

The test involves the total station locking onto and measuring an average position over 
a period of time in both faces to determine any misalignment of the tracker in 
relationship to the telescope cross-hair. If not corrected for, this error results in 
erroneous position determination in both horizontal and vertical axes, and also 
between measurements made with and without Autolock technology. Once measured, 
the error is stored in the total station, and is used to correct all subsequently 
measured positions.

 6. Aim at the target and tap Measure:
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NOTE – There can be two reasons for significant change between old and new values: (1) The 
total station has received a knock or bump in transit that may need a service correction, or (2) 
there has been an observation error.

If you suspect an observation error, repeat the process. If the values are repeated, you 
may want to contact an authorized Trimble Service Center for advice. When the values 
exceed a certain level, you will be advised to send the total station to an approved 
Trimble Service Center for recalibration.

NOTE – The values displayed when new will be close to zero, but over time these are expected 
to change. Non-zero values are no cause for concern; however, sudden large changes should be 
cause for concern because they indicate misuse, abuse, or transportation problems. For full 
details of the instrumentation errors, refer to your instrument manual.

 7. Tap Finish.

Measure Control Network
The Siteworks software includes the Measure Control Network function, which enables 
you to configure and measure rounds of angles to different control points of a network or 
traverse. When you measure at least two rounds to a control point, the software will 
calculate the standard deviation for each foresight and backsight target (accuracy) and the 
standard deviation of the mean (precision). This enables you to evaluate the quality of the 
measurements in the field.
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To use this function, you must purchase and install the Advanced Measurement module. 
When connected to an SPS instrument, the  Total Station Setup menu contains a new 
option called Measure Control Network. To adjust a traverse or control point network 
measured with this feature, you need the Total Station Processing module for the Business 
Center – HCE software. The Siteworks software exports the RAW data to a DC file, which is 
then imported into the Business Center – HCE software.

Measuring rounds of angles
To start the network measurement:

 1. Open a project and work order that contains your existing control points and connect 
the controller to an instrument.

Optionally, you can perform an instrument setup before starting the network 
measurement. This enables you, during the configuration of the network 
measurement, to check the point locations to verify if the prisms were set up over the 
correct control point.

 2. Tap Home / Project Setup / Total Station Setup and select Measure Control Network. 
Tap Accept.

 3. Use the following screen to configure the measurements for a control point:

 4. The Network Measurement dialog contains the following buttons:
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Tap this button … to …

add a new point to the list

measure and add a foresight point to the list

check a point location.

edit point information.

delete a point from the list.

edit the settings for network measurement.

 5. To add an instrument point followed by all the backsight points for your setup, tap 

.

If the Control Point is not included in the Control Point file yet, then enter the 
coordinates in the following dialog:
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 6. In the Measurement Information group, you can decide if an individual control point 
should only be measured reflectorlessly or angle only, and can enter the correct target 
height, target type, and target ID.

 7. When selecting the Autolock option, the instrument will automatically lock on the prism 
after the first set. If you leave this option cleared, you will manually need to aim the total 
station at the prism each time.

TIP – When adding the next point, tap Use Last Settings to copy the settings from the 
previous point so that you do not have to re-enter all the values.

 8. To add and measure new control points as foresight points, tap . To 
configure the point, see Step 4 through Step 5.

 9. If required, tap  to check the point location of an individual point from the list and 
verify that the prism is set up over the correct point.

 10. Tap  to edit the configuration of each point or tap  to delete it from the list 
completely.

 11. Once the configuration is correct, tap Next:
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 12. Tap   to configure the face and round order as follows:

Tap … to set …

F1 all targets only in face 1.

F1 F2 all targets only in face 1 first and then swaps in face 2 and measure 
all targets again.

F1/F2 each target in face 1 and then face 2 before going to the next target.

123...123... all targets in face 1 from left to right then swap in face 2 and measure 
from left to right.

123...321... all targets in face 1 from left to right then swap in face 2 and measure 
from right to left.

 13. To calculate the standard deviation for each target, measure at least two rounds.

 14. Tap Next and then tap Next again to access the Measurement screen. The Siteworks 
software prompts you to aim at the different targets and measure the first set. To 
measure the remaining sets automatically, enable Autolock.

 15. While measuring the second set, the software indicates the differences between face 1 
and face 2. If the measurements are within the tolerances that were entered for the 
differences between face 1 and face 2, the software shows the status “PASS” for that 
point.
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 16. When all of the rounds are measured, the software shows the Standard Deviation of 
Measurements, which is an indication for the accuracy of all of the measurements. The 
Standard Deviation of the Mean gives an estimate of the precision of the 
measurement.

 17. The next screen shows the differences between the measured rounds for each target:

 18. The next screen allows you to select which control points should be stored in the 
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Control Point file of the site. The coordinates are a result of the average angle and 
distance measurements on one control point, but they do not take a traverse or 
network adjustment in account:

 19. Once all measurements and all control points are measured, you can export the RAW 
data of the measurements for doing a network adjustment. Select theHome menu / 
Data Management / Export Measured Data. To adjust the network in the Business 
Center software, export the data with the Network Measurement (DC) option. An 
export for StarNet network adjustment software is also available. Use the Network 
measurement (XSLT). The files with the raw data are stored in the Output folder of the 
current work order.
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Example of a closed-loop traverse

Control points

Building the traverse

Adjusting traverses

A traverse is a surveying method used by construction surveyors to establish horizontal 
and vertical control point networks in situations where high accuracy is needed and where 
GPS is unsuitable to use. The process involves placing survey stations (control points) 
along a path of travel, and then using the previously surveyed points as a base for 
observing the next point.

Traverses consist of three parts: the starting station, the intermediate stations, and the 
ending station. The starting and ending stations may, or may not, be the same control 
point. A traverse is said to be closed when it starts and ends on two sets of known control 
points, and open when it ends on an unknown point. Traverses can be closed with two, 
three, or four control points depending on traverse type, but the starting and ending 
stations must be set on and shot to another control point that existed prior to starting the 
traverse. Currently, the Siteworks software only supports closed traverses.

The intermediate stations are all the stations between the starting and ending station that 
are “set” as part of the traverse. In all configurations, the points these intermediate stations 
are set up on will be adjusted after the traverse measurements are completed.

By using the traverse feature in the Siteworks software, you can run any closed traverse 
and get final adjustment results in the field without needing to export data to other 
software. The adjustment results will match those calculated in a Trimble Business Center 
project.

14
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Example of a closed-loop traverse
Below is an example of a typical closed-loop traverse in which the traverse starts and ends 
on the same control point:

 l The starting station (1) is set on a control point with a backsight (orange line; 2) to 
another control point or known azimuth (3). 

 l The starting station then foresights (purple line; 4) to the first intermediate station (5).

 l Each intermediate station in turn backsights (orange lines) the previous station and 
foresights (purple lines) the next station.

 l The ending station (1)  then backsights the last intermediate station (6) and foresights 
(7) the original control point (3) that was backsighted from the starting station.
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Control points
This chapter assumes that the data collector is already connected to a total station. For a 
detailed description on how to connect to a total station, see Connecting to a total station, 
page 155.

NOTE – The traverse function only works with 3D control points.

To build a closed traverse, control points for the starting and ending stations are required. 
There are multiple ways to obtain control points:

 l Enter and/or edit the coordinates of the point using the Enter/Edit Control Points 
functions.

See The Total Station menu, page 20.

 l Measure the coordinates of the point using the Measure Control Point functions.

See Measuring a new control point with GNSS, page 142.

 l Import control points from a .csv file.

See The Project Setup menu, page 17.
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Building the traverse
NOTE – The traverse workflow only supports closed traverses as open traverses do not allow for 
adjustments (distributing small parts of error) to each measured station.

To build the traverse:

 1. From the Home menu, tap Project Setup and then Total Station Setup:

 2. Select Measure Traverse and tap Accept. The following screen appears:
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 3. To add a traverse station, tap .

The Traverse Measurement Table screen contains the following buttons:

Tap  … to …

measure a new traverse station

remeasure a traverse station

remove the last traverse measurement

clear traverse measurements

 4. In the Instrument Setup window, there are two ways to define an instrument point:

 l Select a control point/point from the map .

 l Select a control point/point from the point list .

NOTE – You can manually enter the control point/point name.

 5. After all the instrument point information is entered, tap Next.

Trimble Siteworks Software User Guide | 206



Traverse Workflow

 6. In the Traverse Measurement screen, enter the backsight and foresight point 
information:

 a. Backsight point:

The backsight point can be selected by two methods:

 i. Select a control point/point from the map .

 ii. Select a control point/point from the point list .

NOTE – You can manually enter the control point/point name.

For subsequent points, the Point name, Target type, and Target height are pre-
filled using the previous instrument point information.
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 b. Foresight point:

When foresighting to an intermediate station, enter the point name, point code, 
target type, and target height.

When foresighting to the ending station, a known control point or point must be 
selected. Enter the target height and ensure that the point name, point code, and 
target type are correct.

 7. After all backsight and foresight information have been verified, tap Measure.

Notes –

The first foresight point is assumed to be a new point, and its name must be entered. For 
subsequent foresight points at intermediate stations, the Point Type must be selected as either a 
New Point or Existing Point.

When checking Autolock, the instrument will lock onto the prism automatically after the first 
measurement set. If this option is left unchecked, the total station must be manually aimed at 
the target each time.

When using the Angle only option, decide if an individual control point should only be measured 
by angle only.

The target type and height must be entered unless using the Angle only option.

Ensure that all input values are correct because it is not possible to edit keyed-in data 
without re-measuring the station.
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To change the Traverse Measurements Settings, tap Settings. For a detailed description of the 
configuration options, see Measuring rounds of angles, page 196.

 8. In the Traverse Measurement screen:

 a. Follow aiming instructions and when prompted, tap Measure.

 b. When all rounds of measurements are completed, tap Next.

 9. Repeat Step 3 through Step 7 to create traverse measurements at all required stations 
and complete building the traverse.
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Adjusting traverses
The Siteworks software will only adjust complete, closed traverses that have starting and 
ending stations on sets of existing control points.

To perform an adjustment:

 1. After completing all traverse measurements on the Traverse Measurement Table 
screen, tap Adjust.

The following screen appears:
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 2. The adjustment settings are:

 a. Adjustment type: Compass or Transit.

 b. Error Distribution for Angular and Elevation: Proportional to Distance, Equal 
Proportions, or None.

 c. Tolerance settings for Horizontal and Vertical precisions: Enter manually.

 3. When all of the adjustment settings are entered and a filename has been entered, tap 
ACCEPT.

 4. After performing the adjustment calculations, the results are displayed for review in a 
Traverse Adjustment report. To modify the Traverse Adjustment Settings again, tap 
Back.

 5. If the report generated is accepted, the adjusted traverse points can be saved as 
control points by tapping ACCEPT.
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Pairing and connecting to Vivax-Metrotech locators

Pairing and connecting to Radiodetection instruments

Testing the locator in Siteworks

Operating the locator with Siteworks

15
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Overview
Siteworks can connect to and log the data stream of several radio frequency utility locator 
instruments including the Radiodetection RD8000 and 8100 models, and the Vivax-
Metrotech vLocPro2 model.  

Functional integration of the locators into the Siteworks software includes the ability to 
record position measurements within Siteworks from GNSS and total stations and log the 
depth and other data output from the locator by pressing the Depth button on the locator 
wand.  The locator triggers a measurement in Siteworks and also records the data 
streamed out of the locator by using a Bluetooth connection between the locator and the 
data collector.  

The depth of the utility as calculated by the locator can be subtracted off the elevation at 
the survey rod tip. This results in the recording of the elevation of the utility.  The additional 
information stored by Siteworks depends on the locator model, and can include, the 
selected locator frequency, gain settings, locate current, and other information as output 
by the locator.  Please refer to the utility locator manuals for correct operating instructions 
of those devices, for additional information on setting up the streaming outputs, and the 
types of information output by the locators.

Locator functionality in Siteworks is enabled by selecting the Enable Utility Locator Setup 
in the CTRL+O menu.  
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After the Enable Utility Locator Setup check box is selected, tapping the Home menu, 
Measure shows a new menu item for utility locator setup.

Tapping the Utility Locator Setup tab opens the Utility Locator Setup screen where the 
locator model, communication protocols, option for subtracting out the depth calculated 
by the locator are shown, in addition to enabling the connecting, disconnecting, and 
testing of the locator’s output in Siteworks.
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Pairing and connecting to Radiodetection instruments
Radiodetection locators must first be paired in the data collector’s Windows operating 
system outside of the Siteworks software. The COM port that is determined is set up by the 

collector in order to operate.  Tapping  to the COM port field when the Radiodetection 
is selected in the Utility Locator Setup screen shows the following window:

Pairing Radiodetection locators with a Windows 10 Tablet
The following sections are for pairing the Radiodection instrument on the Trimble Site 
Tablet 10, TSC7, T10 and other Windows 10 devices.  

 1. Select the Add a Bluetooth device from the Bluetooth menu item in the Windows 
taskbar and set the Radiodetection Locator into pair mode as described above.
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 2. After the Radiodetection locator appears in the device list, click on it to begin the 
pairing process.  Enter 1234 for a pairing code and tap Next.
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 3. Determine the incoming COM port established for the locator by selecting the Open 
Settings command in the Bluetooth Windows taskbar icon menu.  Then tap on the COM 
Ports tab to see a list of the COM ports established on the tablet:
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 4. Note the incoming port assigned to the RD8100 or RD8000 displayed in the window (in 
this example COM5) as this will be entered into the Siteworks software.

 5. Back in the Siteworks software, return to the Utility Locator Setup screen. From the 
Brand field, select Radiodetection. Enter the incoming COM port determined in the 
above steps during Bluetooth pairing.
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 6. After configuring the device, entering the COM port, and selecting if the calculated 
depth from the locator is to be subtracted from the measured surface elevation, tap 
Connect to connect to the locator.
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Pairing and connecting to Vivax-Metrotech locators
For Vivax instruments it is only necessary to ensure that the Bluetooth Search setting in the 
settings menu on the locator is set to “Enabled” to establish a connection with Siteworks. 

To access the locator’s settings menu:

 1. Press and hold the “ i ” (information depth/current) button on the Locator, and then 
the “+” button on the locator to navigate to the locator’s Bluetooth menu options.

 2. Press the Locate Mode (rightmost) button on the locator to enable the Bluetooth 
search setting until the screen on the locator displays the message: Bluetooth Search: 
Enabled.  

 3. Once this is enabled, you can perform a Bluetooth search and connect to the locator 
from within the Siteworks Utility Locator Setup window.

To connect to the vLocPro2:

 1. From the Brand field, select Vivax-Metrotech.

 2. On the right side of the Device name field, tap    to begin a Bluetooth search for the 
Locator in Siteworks:

 3. After finding the Locator and completing the Bluetooth pairing process within 
Siteworks, select the vLocPro in the Device name field. 

Trimble Siteworks Software User Guide | 221



Utility Locator Workflow

 4. Set the required option for applying the depth correction to measured points and 
then tap Connect.  

 5. The Bluetooth icon on the Locator screen should turn blue and illuminate and the 
Connect button should change to Disconnect, indicating a connection has been made 
to Siteworks:
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Testing the locator in Siteworks
After pairing and connecting the locator in the Siteworks software, pressing the Test 
button in the Setup screen will open a screen where the output from the locator can be 
seen.  This screen enables the checking of the connection between the collector and the 
locator and previewing the data that will be logged by Siteworks.  

Press the Depth button on the Radiodetection devices or the “i” and then “+” button on 
Vivax-Metrotech devices to send the string of data from the locator to Siteworks and 
ensure that the correct data are being sent.  Tap Close when done to return to the Utility 
Locator Setup Screen.

Example Vivax-Metrotech test data:
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Example Radiodetection test data:

Note that if you are using a Radiodetection locator and receive the error shown below, this 
indicates that the locator’s output is not configured to the ASCII – 1 protocol.  See Pairing 
and connecting to Radiodetection instruments, page 215 for how to configure 
Radiodetection Locators to the correct output protocol.
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Operating the locator with Siteworks
Once the locator is correctly configured and connected to the Siteworks software, 
whenever Siteworks is in measure mode pressing the depth button on the locator will 
trigger either a point or line measurement in Siteworks depending on what measure type 
is selected. Depth and other data streamed from the location is also recorded.

Pressing the Measure key while connected to a locator will record a normal measurement 
that will not include any information from the locator. The only way to record locator data 
in Siteworks is by triggering the measurement by pressing the Depth button on the 
locator. The locator cannot be used to trigger a measurement while in Stake mode.

If the Apply Depth Correction is set to Yes in the Utility Locator Setup screen, then the 
depth calculated by the locator will be subtracted from the survey rod tip elevation.  This 
will record the elevation of the utility.  The original, unadjusted surface elevation is also 
recorded with the point, but the measured point stored in Siteworks will represent the 
surface elevation at the rod tip minus the depth the locator calculated.

For best results, ensure that both the locator and survey rod tip are in the proper location 
when a measurement is triggered with the locator depth button.  Refer to the locator’s 
operating instructions for how to obtain the best quality depth readings, to understand 
the limitations of the calculated depth values, and for more information on setting up the 
Bluetooth connections.

A preview of the data output from the locator is shown in the Measure Type screen for 
point measurements before being stored.  Tap Accept to record the point and store the 
data.  This preview function is not available for line measurements, as those are always 
stored without a preview option.
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The stored locator data for both points and line points can also be reviewed by tapping 
and holding on a point and selecting Point Information or via the Point Manager.
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While measuring, consider the line measurement type, especially if applying depth 
corrections based on the locator output.  For example, if you are measuring surface 
topography for grade checking, then it may not be desired to measure utility lines as 
breaklines or volume boundaries, or include utility point measurements in as surface 
points (i.e., set them as “feature” points in the Measure Type settings) as not to disrupt any 
other measured surface points.

To export the recorded locator data for use in other software programs, select the Include 
QA data option in the CSV export of Measured Data.  The locator data is also included in the 
exported Record.txt file.
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benching Benching is a process of aligning your GNSS position (latitude, 

longitude, and height) to a benchmark that has been added as a 
reference point. The calibration offsets your GNSS position to that of 
the benchmark, improving accuracy and providing a point that you can 
return to later.

AutoBase AutoBase technology uses the position of the receiver to automatically 
select the correct base station; allowing for one button press 
operation of a base station. It shortens setup time associated with 
repeated daily base station setups at the same location on jobsites.

BaseAnywhere BaseAnywhere technology allows the user to place the GNSS base 
station anywhere on site and does not require the base station to be 
setup on an existing control point.  After the base is configured in 
BaseAnywhere mode it calculates an autonomous position and begins 
broadcasting corrections via radio or Wi-Fi.  The rover is then used to 
bench into a control point which calculates the necessary offsets and 
parameters to allow for fully accurate RTK GNSS operations.  

base station Also called reference station. In construction, a base station is a receiver 
placed at a known point on a jobsite that tracks the same satellites as 
an RTK rover, and provides a real-time differential correction message 
stream through radio to the rover, to obtain centimeter level positions 
on a continuous real-time basis. A base station can also be a part of a 
virtual reference station network, or a location at which GNSS 
observations are collected over a period of time, for subsequent 
postprocessing to obtain the most accurate position for the location.

DGPS See real-time differential GPS.

design map The map that provides live linework within a design for stakeout 
operations. The design map is a DXF file.

differential 
correction

Differential correction is the process of correcting GNSS data collected 
on a rover with data collected simultaneously at a base station. 
Because the base station is on a known location, any errors in data 
collected at the base station can be measured, and the necessary 
corrections applied to the rover data.

Differential correction can be done in real-time, or after the data is 
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collected by postprocessing.

differential GPS See real-time differential GPS.

elevation (elev, 
elv)

(1) Vertical distance (height) above or below mean sea level. (2) Vertical 
distance above or below the geoid. (3) Distance above or below Local 
Datum.

elevation mask The angle below which the receiver will not track satellites. Normally set 
to 10 degrees to avoid interference problems caused by buildings and 
trees, atmospheric issues, and multipath errors.

feature A feature is a physical object or event that has a location in the real 
world, which you want to collect position and/or descriptive 
information (attributes) about. Features can be classified as surface or 
non-surface features, and again as points, lines/breaklines, or 
boundaries/areas.

GLONASS Global Orbiting Navigation Satellite System. GLONASS is a Soviet space-
based navigation system comparable to the American GPS system. The 
operational system consists of 21 operational and 3 non-operational 
satellites in 3 orbit planes.

GNSS Global Navigation Satellite System.

GPS Global Positioning System. GPS is a space-based satellite navigation 
system consisting of multiple satellites in six orbit planes.

height It can mean a target height or antenna height ( for example, 2 m of rod 
height).

Here position An autonomous instantaneous position derived from the GPS 
receiver’s uncorrected latitude, longitude, and height.

IBSS Internet Base Station Service. This Trimble service makes the setup of 
an Internet-capable receiver as simple as possible. The base station 
can be connected to the Internet (cable or wirelessly). To access the 
distribution server, the user enters a password into the receiver. To 
use the server, the user must have a Trimble Connected Community 
site license.

Location GPS Location GPS covers decimeter to submeter GNSS positioning 
techniques including Satellite Based Augmentation Systems (SBAS) 
such as WAAS, EGNOS, and MSAS), DGPS (reference station and rover 
operations), OmniSTAR VBS/HP/XP services, and Location RTK 
(decimeter-level RTK positioning).
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Location RTK Some applications such as vehicular-mounted site supervisor systems 
do not require Precision RTK accuracy. Location RTK is a mode in 
which, once initialized, the receiver will operate either in 10 cm 
horizontal and 10 cm vertical accuracy, or in 10 cm horizontal and 2 cm 
vertical accuracy.

Precision GPS GPS positioning provided by techniques that typically deliver 
centimeter-level accuracy. These include RTK (Real-Time Kinematic) 
techniques and signals obtained from a VRS (Virtual Reference Station) 
system.

Project A project that is to be worked on for a significant period of time. A 
project stores all design data and all executed work orders so you can 
easily find data whether you are in the office or in the field.

postprocessing Postprocessing is the processing of satellite data after it is collected, in 
order to eliminate error. This involves using computer software to 
compare data from the rover with data collected at the base station.

real-time 
differential GPS

Also known as real-time differential correction or DGPS. Real-time 
differential GPS is the process of correcting GPS data as you collect it. 
Corrections are calculated at a base station and then sent to the 
receiver through a radio link. As the rover receives the position it 
applies the corrections to give you a very accurate position in the field.

Most real-time differential correction methods apply corrections to 
code phase positions.

While DGPS is a generic term, its common interpretation is that it 
entails the use of single-frequency code phase data sent from a GNSS 
base station to a rover GNSS receiver to provide sub-meter position 
accuracy. The rover receiver can be at a long range (greater than 100 
kms (62 miles)) from the base station.

Road job A road job is the term that defines a complete road model within the 
Terramodel and Siteworks software. It is a collection of roadway 
information that is expected to function together to define a roadway 
or a portion of a roadway between specific stationing limits. A road job 
contains the main alignment and all sub alignments, the road 
templates, and all the information used to define widening and super 
elevation for the road. A single project can contain multiple road jobs 
for different roads also contained within that single construction 
project.

road model The road model used by the Siteworks software is a Trimble 
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  Terramodel PRO file. This file can be used for both staking and grade 
checking operations. The Road model is a template based model that 
provides full accuracy anywhere within the roadway surface.

rover receiver A rover is any mobile GNSS receiver that is used to collect or update 
data in the field, typically at an unknown location.

Roving mode Roving mode applies to the use of a rover receiver to collect data, 
stakeout, or control earthmoving machinery in real time using RTK 
techniques.

RTK real-time kinematic. A real-time differential GPS method that uses 
carrier phase measurements for greater accuracy.

site map The site map within the Siteworks software is stored as a part of the 
site data. The site map provides linework as a reference only and is not 
live, which is why you cannot select it for stakeout purposes.

station A station is the running distance along the centerline or road that 
starts at 0.0 and increments as you proceed along the route. This term 
is used primarily in the US, whereas the equivalent term chainage is 
used throughout many other areas of the world, such as Australia, 
Asia, Europe, and New Zealand.

surface model The surface model used by the Siteworks software is a Trimble Terrain 
Model file (TTM file). It provides a 3D surface model that can be used for 
stakeout or grade checking operations.

work order A work order covers a task to be performed by a crew on a single 
jobsite. A work order contains the reference to the appropriate design, 
required settings and tolerances for the task, and a record and report 
of all the data measured or staked out in the process of completing the 
task.

A work order can cover a short-term task (such as the stakeout of a 
specific building pad) or a task that will last the duration of the project 
(such as the stakeout of storm water drainage) and that will be 
executed periodically as required during the project.

When the project is complete, all the information regarding the task is 
stored in a single file that is easy to recall.
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